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1▼  ▼  ▼  ▼
Getting Started
This document explains how to view SCSI devices and manage 
arrays with the Adaptec® CI/O™ Management Software. It includes 
instructions on using all the software features and also information 
on how to replace drives, reconstruct arrays, etc.

You install the Windows® client version of Adaptec CI/O 
Management Software on networked clients running under 
Windows® 95 or Windows NT™ 3.51 or 4.0. You may also install it 
directly onto servers running under Windows NT. Adaptec CI/O is 
used to monitor and manage server and array activities. CI/O gives 
you access to information on multiple servers to which the client is 
connected via the network and instant notification of storage-related 
problems.

This version of Adaptec CI/O Management Software (v3.3) 
supports the following Adaptec products:

■ AIC-78xx devices (for example, the AHA-2940 host adapter) 
with the Adaptec 7800 Family Manager Set v2.10 or higher. 
Ultra2 SCSI host adapters require v3.00 or higher of the Family 
Manager Set (v3.01 or higher for Novell NetWare).

■ ARO-1130SA, AAA-131SA, AAA-132SA, and AAA-133SA, 
with the Array1000SA Family Manager Set v. 3.3 or higher.

■ These Adaptec bridge controllers: AEC-4312AS, AEC-4312AD, 
AEC-4412BS8, AEC-4412BD8, AEC-7312A, and AEC-7412B

In this document the Adaptec Array1000SA Family products and 
the Adaptec bridge controllers are sometimes referred to as 
“Adaptec RAID products” or “array controllers.”
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Using the Adaptec CI/O Management Software
Here is some general information on using the Adaptec CI/O 
Management Software most effectively. Use the Table of Contents 
and the Index to find instructions for specific software commands.

■ Use Adaptec CI/O Management Software to monitor the 
status of SCSI devices, arrays, and other devices on the server. 
This software allows you to receive status updates from 
multiple remote servers. You can simultaneously monitor 
servers running under different operating systems.

■ Use Adaptec CI/O Management Software to set up regularly 
scheduled verification of fault-tolerant arrays and testing of 
spares. Respond immediately to arrays in Critical status, and 
replace failed spare disks promptly.

■ Use Adaptec CI/O Management Software, running either on 
the server console or on a networked client, to add, delete, or 
reconfigure arrays after the server has already been in use. 
(You need special access rights to change the server 
configuration.)

■ We recommend that you create a bootable array and boot the 
server from the array instead of from a stand-alone disk drive. 
You can create a bootable array with either Adaptec CI/O 
Management Software or the ArrayConfigSA program, which 
is described in Appendix C. (See the Installation and Hardware 
Guide for more information on configuring a bootable array.)

■ Use the password feature of Adaptec CI/O Management 
Software to prevent unauthorized users from changing your 
array configuration.

■ Be sure that arrays are adequately protected with spare pools 
(recommended) or dedicated spares. You can create and delete 
spares with any of the array management software programs.

Note: Your Adaptec product also includes the diskette-based 
ArrayConfigSA Initial Boot Array Installation Utility, which 
you can use to create arrays and spares. You can use 
ArrayConfigSA to create an initial bootable array for the 
server. See Appendix C, Using the ArrayConfigSA Initial Boot 
Array Installation Utility, for more information.
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Conventions
This document uses the following typographic conventions:

bold
Used for key names (… press the Enter key …) and for options 
you are told to select (… select Configure SCSI Channels…).

Helvetica
Used for screen messages (…Save changes?…) and for text 
that must be typed exactly as shown.

Helvetica Italics
Used for program and file names when referenced in the text 
(… these changes are made to the config.sys file…).

❒
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2▼  ▼  ▼  ▼
Entering and Viewing 
Server Information
Adaptec CI/O Management Software allows you to view events 
taking place on multiple servers. In addition, you can view the 
configuration of SCSI devices, arrays, and other hardware on the 
server(s). This chapter explains how to view client and server 
information. Chapter 3 describes how to view SCSI adapters and 
devices. Chapter 4 explains how to view arrays, disks, and other 
SCSI devices attached to every controller within the server.

Entering and Viewing Server Information

Adding a New Server Address
You must enter information about each server you want to monitor 
with Adaptec CI/O Management Software. Once this information is 
recorded in a configuration file, Adaptec CI/O Management 
Software automatically finds the server(s) when restarting the 
application.
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Follow these steps to add a new server address to Adaptec CI/O 
Management Software:

1 Start the program by double-clicking the  icon in the 
Adaptec CI/O Management Software group.

2 Click the  button. The New Server dialog box appears, 
as shown in Figure 2-1.

3 Select the IP or IPX radio button to indicate which kind of 
access is the default.

4 Enter the server’s name or IP/IPX address, which can be up to 
32 characters. This name will appear beneath the server icon in 
the Server View window.

– Servers running under NetWare usually use IPX protocol. 
Select the IPX button and type the name of the server. To 
view the server name, open Windows File Manager, select 
Connect Network Drive from the Disk menu, and view the 
scrollable list of server names. If an error message appears 
when you click OK in the New Server dialog box, verify the 

Figure 2-1. New Server Dialog Box
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server name and the use of IPX with the System 
Administrator.

If you need to enter an IPX address, the format is 
xxxxxxxx.xx-xx-xx-xx-xx-xx, where the first eight x’s are hex 
digits that define the network number, and the six pairs of 
hex digits are the host address or MAC address.

– Servers running under Windows NT usually use IP 
protocol. For Windows NT you can always enter the server 
address, if known. Otherwise, enter the server name. This 
could be something like mainserver.unisystem.com or 
mainserver. Be sure that the networked client is set up with 
either a host file or with the name of a domain resolver. Ask 
the System Administrator if you are not sure.

The format of a TCP/IP address is nnn.nnn.nnn.nnn, where 
each group of three decimal digits is a number between 0 
and 255 (for example, 123.23.45.145).

Note: If you are only monitoring Windows NT servers, 
and you are not monitoring any NetWare servers, we 
recommend that you set the IPX= variable to 0 in the 
cioams.ini file. For more information, see the 
description of the IPX= variable under cioams.ini on 
page A-4. Appendix A also has information on other 
configuration options.

5 Enter a description of the server—for example, Application 
Server or Video Server. This description appears when you 
double-click the server icon in the Server View window.

6 Click OK to add the new server information. You will see one 
of the following error messages if the server name/address is 
not correct:

– RPC transport error. This means that you entered a server 
address with correct IP or IPX syntax, but there is no server 
with this address. Check your typing for errors and try 
again.

– Transport not present. This means that the selected protocol 
transport is not present.
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– Duplicate server exists. This means that you entered a 
server name or address that has already been added for this 
networked client monitoring list.

Viewing and Editing Server Information
Follow these steps if you need to enter or change a server’s network 
address information from the top menu bar of the CI/O 
Management Software main screen:

1 Click the  button on the toolbar. The Server View 
window appears. Each server is represented by an icon in the 
top part of the window. The appearance of the icon indicates 
the server status, as shown here:

Server is online and available.

Server is unavailable, perhaps due to a network failure. 
The Adaptec CI/O will automatically attempt to 
reattach to the server for a user-selectable time (default 
is 10 minutes). Double-click the server icon at any time 
to attempt a reattach.

Server has generated a critical event message.

Guest access to server is disabled. To access server 
information, double-click the icon and enter the server 
password when prompted.

Server has generated a warning event message, such as 
an array in Critical status.

Adaptec CI/O has lost communication with the server.
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2 Double-click a server icon in the Server View window. The 
Server Information dialog box appears, similar to Figure 2-2.

3 View the server name, IP address, or IPX address.

4 View or edit the server description. The description is for your 
information only and appears only in this dialog box.

5 Click OK to exit the Server Information dialog box and to 
retrieve any updated server information.

Figure 2-2. Server Information Dialog Box
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Deleting a Server Address
When you delete a server address, the icon for the server no longer 
appears in the Server View window and you can no longer view 
information for that server or manage it with Adaptec CI/O 
Management Software.

Follow these steps to delete a server address:

1 Select Server View from the File menu.

2 Click the icon  of the server you want to delete.

3 Select Server Delete from the File menu. A prompt appears 
asking you to confirm the deletion of the currently selected 
server address.

4 Click Delete to delete the server address.

Note: If you attempt to delete a server address from a 
networked client while the server is off-line, the client will 
attempt to reconnect to the server. After this attempt fails, 
which may take a few seconds, the server address is deleted.

Viewing a List of Current Server Events
When you run Adaptec CI/O Management Software, you can use 
the Server View window to monitor events on all servers to which 
you are connected. Event notifications appear at the top of the list as 
they are received, starting from the time when you connect to the 
network. A color-coded circle at the beginning of each message 
gives you a quick indicator of its severity.

If you minimize Adaptec CI/O Management Software, the icon 
flashes whenever a new event notification is received.
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Follow these steps to view a list of current server events in the 
Server View window:

1 Select Server View from the File menu. The Server View 
window appears. The Global Current Event Log at the bottom 
of this window lists server events, as shown in Figure 2-3.

2 View the event information for one or all servers. New entries 
appear on the list as the server events occur, and a date and 
time is listed for each event. See Interpreting and Responding to 
Server Event Messages on page 2-12 for more information on 
how to respond to these messages.

Note: The client sorts events from different servers in 
different time zones after adjusting the timestamp for each 
event to the client’s local time. In other words, events are 
sorted correctly by absolute time of occurrence and are then 
displayed in the remote client’s local time.

Figure 2-3. Listing of Server Events
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3 To view detailed information about an event, double-click the 
list entry. The Log Detail dialog box appears, as shown in 
Figure 2-4.

The information displayed in the Log Detail dialog box is 
similar to what appears in the one-line log entry, but the format 
is more readable.

4 Click OK when you are finished viewing the Log Detail dialog 
box. When you do this, you notify Adaptec CI/O Management 
Software that you have read the event notification.

– To acknowledge all new event notifications from all servers 
without reading each individually, click OK to All at the 
bottom of the Server View window. This stops the Adaptec 
CI/O Management Software icon from flashing when the 
application is minimized.

– To acknowledge all new event notifications from the currently 
selected server without reading each one individually, click 
OK to Server at the bottom of the Server View window.

Figure 2-4. Log Detail Dialog Box
2-8



Entering and Viewing Server Information
5 Click Filter in the Server View window to filter the events 
notifications in this window by severity. (See Changing Filter 
Options below.)

6 Click Save As to save the event list to a file.

7 Close the Server View window when you are finished viewing 
the server events or leave it open so you are aware of server 
events as they occur.

Changing Filter Options
You can control what kinds of event entries are listed in the Global 
Current Event Log (part of the Server View window) and the 
Historic Event Log window. You can set the Filter options globally, 
or you can customize them for individual windows. Follow these 
steps to change the filter settings globally:

1 Click the  button on the toolbar. The Preferences dialog 
box appears.

2 Click Filter. The Default Event Viewing Filter dialog box 
appears, as shown in Figure 2-5.

3 Select or deselect the Critical, Warning, or Informational 
entries to control which kinds of messages appear in the Global 
Current Event Log and the Historic Event Log. (We 
recommend that you select all the boxes.) If you choose not to 
display some kinds of messages, the Items displayed number 
above the log entries lists the number of messages that are 

Figure 2-5. Default Event Viewing Filter
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actually displayed. The Items total field always indicates the 
total number of messages of all types.

4 Click OK to record the Filter option changes.

To change the Filter options only for a specific window, open the 
Server View or Historic Event Log window and click Filter. Change 
the options as described above and click OK. The changed settings 
apply to this window only while it is open; the settings will return to 
the defaults if you close and re-open the window or if you restart 
Adaptec CI/O Management Software.

Choosing Notification Settings
The notification settings determine how you are notified of events 
that occur on servers to which Adaptec CI/O Management Software 
is connected. The text describing these events appears in the list of 
current server events and the Historic Event Log window.

Follow these steps to choose notification settings:

1 Click the  button on the toolbar. The Preferences dialog 
box appears.

2 Click Notification; the Event Notification Options dialog box 
appears, as shown in Figure 2-6.

Figure 2-6. Event Notification Options Dialog Box
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3 Select Pop-up Box, Beep, and/or Flash Title Bar to control 
how you will be notified of events that occur on servers to 
which Adaptec CI/O Management Software is connected.

Note: Regardless of the options you choose, Adaptec 
CI/O Management Software will always notify you of 
Critical events with a pop-up message, a beep, and a 
flashing title bar.

4 Click OK to save these settings.

Viewing Historical Server Information
You can view a log of historical information for any single server to 
which Adaptec CI/O Management Software is connected. This 
information is retrieved from the server.

Follow these steps to view historical server information:

1 Click the  button on the toolbar. The Historic Event Log 
window for the currently selected server appears, as shown in 
Figure 2-7.

Figure 2-7. Server Historic Event Log Window
2-11



Adaptec CI/O Management Software User’s Guide
2 View the historical information for the server. New entries are 
added to the top of the list as they occur. A color-coded circle at 
the beginning of each message indicates its severity. (See the 
next section, Interpreting and Responding to Server Event 
Messages, for more information.)

3 To view detailed information about an entry on the list, 
double-click the entry. The Log Detail dialog box appears, as 
shown in Figure 2-4 on page 2-8.

4 Click OK when you are finished viewing the Log Detail dialog 
box.

5 Click Filter to change the Message Filter options. Click OK to 
All to acknowledge all new event notifications without 
reading each one. (This stops the minimized Historic Event 
Log icon from flashing.) Click Clear All to delete all log 
entries. Click Save As to save the log to a file.

Note: When you open the Historic Event Log window, 
only the most recent log entries are initially displayed. 
If you scroll down beyond these entries, another 
group of entries are retrieved. This avoids the delay 
that might occur if an entire large log file were 
retrieved from the server at one time. To keep the 
Server Log file from getting too large, specify a 
maximum size for it in the initialization file. (See 
Appendix A, Configuration Settings.)

6 Close the window when you are finished viewing log entries, 
or minimize it as an icon on the screen.

Interpreting and Responding to Server Event 
Messages
There are three severity levels for server events:

■ Critical event messages (red) indicate an array or server 
problem that requires immediate action. An example is an 
array going off-line because two array members have failed. 
See Responding to an Off-Line Array on page 9-5 for more 
information.
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■ Warning event messages (yellow) indicate an array or 
server problem that may require attention. An example is a 
paused channel or a fault-tolerant array with a failed disk. If 
no spare is available to replace the failed disk, take action 
immediately before another disk fails. See Responding to a 
Critical Array on page 9-1 for more information.

■ Informational event messages (green) contain 
information about a normal operation, such as creating a new 
array, adding a spare, or verifying an array.

Entering and Viewing Preference Information
You use the Preferences dialog box to enter or view information 
about how event notifications are received from servers and to 
enable and configure password protection for servers and 
networked clients.

Follow these steps to change or view preferences information:

1 Click the  button. The Preferences dialog box appears, as 
shown in Figure 2-8.

Figure 2-8. Preferences Dialog Box
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2 You can enter a different name for the configuration file that is 
stored on the networked client. Click the Browse button if you 
want to store this file in a different directory on the client’s 
hard drive.

3 Click Notification to change the way in which you are alerted 
of event notifications sent from servers. The Event 
Notifications Options dialog box appears, as shown in Figure 
2-6 on page 2-10. Select one or more of the available options.

4 Click Filter to view the Log Filter dialog box. Select or deselect 
the check boxes, to filter the types of messages that appear in 
the window. We recommend that you select all the boxes so 
you are fully informed of server events.

5 Select a Password Time-out option to set the level of password 
protection for this workstation or server. See Setting Password 
Time-out Options on page 8-3 for more information.

6 Click OK to change the option information or to close the 
dialog box.

Editing the Permanent List
Each server maintains a permanent list and an active list of networked 
clients. Clients that communicate with the server are automatically 
added to the server’s active list. Adding a client name to the 
permanent list allows that client to receive event notifications from 
the server even when it is not actively monitoring the server. (If a 
client is on the server’s permanent list but not the active list, the 
server icon does not appear in the Server View window.) You can 
delete the client name if you no longer want to be notified of events 
on a particular server.

When you edit the permanent list, you are required to enter the 
server password.

Caution: We recommend that you do not use the Permanent 
Notification feature for normal communications between 
servers and networked clients. Servers can use the active list 
to rapidly communicate new events to networked clients.

!
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Follow these steps to add clients to or delete clients from the 
permanent list:

1 Open the Server View window and select the icon of the server 
whose permanent list you want to edit.

2 Select Server Administration from the View menu.

3 Select Edit Permanent List. Enter the server’s password at the 
prompt. The Edit Permanent List dialog box appears, as shown 
in Figure 2-9.

The list box shows the entries that are currently in the selected 
server’s permanent notification list.

4 To add a new networked client entry, type the IP or IPX 
address in the field at the top of the screen, select IP or IPX, 
and click Add.

5 To delete a networked client entry, highlight the entry in the 
list box and click Delete.

6 Click Close when you are finished. The changes are registered 
in the server’s permanent list file.

❒

Figure 2-9. Edit Permanent List Dialog Box
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3▼  ▼  ▼  ▼
Viewing SCSI Device 
Information
You can view the status of SCSI devices connected to one or more 
SCSI adapters from the Physical Resources window, as shown in 
Figure 3-1. Unlike SCSI devices and arrays associated with array 
controllers, these devices cannot be configured to create logical 
arrays from the graphical user interface. These devices are, however, 
checked and updated by a separate process that is specific to SCSI 
adapters. Refer to Managing SCSI Adapters on page 3-8.

Note: To view SCSI devices attached to AIC-78xx channels 
on Windows NT servers, Adaptec EZ-SCSI® software must 
be installed.

Figure 3-1. Physical Resources

SCSI Adapter 
(view and 
monitor)

Array Controller 
(user-
configurable 
arrays and SCSI 
devices)
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Viewing Arrays from an External RAID Controller
A bridge controller connects Fibre Channel-to-SCSI or SCSI-to-SCSI 
external intelligent RAID array controllers to bridge the host I/O 
interface to multiple back-end device channels. Although these 
devices appear under a SCSI channel, they are capable of the same 
functionality as SCSI devices connected to array controllers. Figure 
3-2 shows a bridge controller with a single “New Array” connected. 
For more information on how to view and configure arrays, refer to 
Configuring Arrays and Spares on page 4-1.

Figure 3-2. Detail of Bridge Controller and Arrays

Follow these steps to view configuration information for a device:

Note: The software scans the server every 3 minutes to 
detect status changes for any installed SCSI adapters and 
devices. No changes are detected until that scan has 
occurred. Changes to array controller status, in contrast, are 
detected immediately if I/O is present.

1 Select Configuration from the View menu, or click the  
icon on the toolbar.

SCSI 
Adapters

Bridge 
Controller

Array Members
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Viewing SCSI Device Information
2 When the Storage Configuration window appears, double-
click the icon of the device for which you want information. 
The icons are as follows:

– SCSI adapter, SCSI RAID card, or external RAID 
controller

– Channel

– Disk Device

– CD-ROM Drive

– Tape Drive

– Scanner

– Printer

The SCSI Device icons shown above represent physical devices 
that appear on the left side of the window. Physical means that 
the icons correspond to actual devices installed in the server, 
such as a SCSI drive or a CD-ROM drive.

The following sections explain the information that appears when 
you click an icon for a device.
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Viewing the SCSI Information Dialog Box

When you double-click a SCSI Device icon, such as a disk or 

a CD-ROM drive , the SCSI Information dialog box appears, 
as shown in Figure 3-3.

The dialog box shows device type, manufacturer, model, channel, 
SCSI ID data, and other pertinent information for the specific device.

Note: Status field information is only provided for disk 
drives and CD-ROM drives.

Click Close to close the SCSI Information dialog box.

Figure 3-3. SCSI Information Dialog Box
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Viewing SCSI Adapter Information

When you double-click a SCSI Adapter icon , the 
Controller Information dialog box appears, as shown in Figure 3-4.

The PCI bus number field indicates which PCI slot the card is 
installed in.

Click Capabilities to view a list of the features supported by this 
device. You cannot enable or disable the capabilities on the list. 

Click Close to close the Capabilities dialog box and the Controller 
Information dialog box.

Figure 3-4. Controller Information Dialog Box
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Viewing SCSI Channel Information
When you double-click a Channel icon , the Channel 
Information dialog box appears, as shown in Figure 3-5.

The following information appears in the Channel Information 
dialog box:

■ Status: current operational status of the channel (for example, 
Active, Inactive).

■ Channel type: type of this channel—for example, SCSI.

■ Maximum Devices: maximum number of SCSI devices that 
the channel supports. The channel itself counts as 1 device so if 
this number is 16, for example, you can connect up to 15 
devices.

■ Current Devices: number of SCSI devices currently connected 
to the channel.

Click Close to close the Channel Information dialog box.

Figure 3-5. Channel Information Dialog Box
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Rescan
After you have removed a device from the server, the user interface 
may continue to display it as disconnected in the Physical Resources 
dialog box. If this happens, you should select Rescan.

The Rescan function works differently for a SCSI adapter than it 
does for an Adaptec RAID product. A SCSI rescan deletes the 
database and then performs a discovery phase to find all devices 
connected to the server. An update is made to the user interface in 
the Physical Resources dialog box. Refer to Managing SCSI Adapters 
on page 3-8 for information on discovery.

With Adaptec RAID products, information is stored in reserved 
sectors. When you select Rescan, the program quickly updates the 
reserved sectors.

In contrast, information related to SCSI adapters is stored in the 
iomaspi.dev file. When the server boots up, it reads information 
from that file. When you select Rescan, the program deletes the file, 
rewrites it, and then updates the program.

Rescan Details
While adapters are being rescanned, the program displays 
indicators over each adapter icon to show that the rescan has not 
completed its discovery of all SCSI devices on that adapter. 

If SCSI adapters and Adaptec RAID products are installed in the 
same server, the system will typically complete the rescan for the 
Adaptec RAID products, repaint the screen, then rescan the SCSI 
adapters. The repaint for SCSI adapters will not occur until the 
discovery of all adapters is complete. 
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Managing SCSI Adapters
SCSI devices that are attached to an Adaptec SCSI adapter are 
managed differently than those attached to an Adaptec RAID 
product. For each device attached to an Adaptec AHA®-2940 or 
AHA-1540, the Adaptec CI/O Management Software interrogates 
the system to detect possible device failures.

Adaptec CI/O Management Software performs three distinct tasks 
for SCSI adapters: Discovery, Poll, and Statistics. The time the 
software takes to detect system changes is directly affected by how 
the Discovery/Poll cycles respond. Devices that are new or 
recovered are detected at the next Discovery cycle; devices that have 
failed are detected at either the next Poll or Discovery cycle, 
whichever occurs first.

■ Discovery—Analyzes the current configuration and compares 
it with the previous configuration. This phase requires that 
SCSI commands time out for every device that is not present. 
Therefore, the Discovery phase can be lengthy.

By default, the software runs the Discovery phase every 
30 minutes. This can be modified in the iomgr.ini file on the 
server.

During the Discovery phase, the Adaptec CI/O Management 
Software performs the following steps:

– Determines the number of SCSI adapters installed

– Performs a host adapter inquiry on each installed SCSI 
adapter to determine its characteristics

– For each SCSI adapter, performs a SCSI inquiry command to 
every possible target device to determine the presence and 
characteristics of all devices 

Adaptec CI/O Management Software records in an internal 
table all information discovered about SCSI adapters and 
devices. If an internal table already exists, discrepancies 
between the current system configuration and the internally 
recorded configuration are checked, tables are updated, and 
the display is updated. 

■ Poll—Validates Discovery information. Adaptec CI/O 
Management Software attempts to contact devices that are 
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previously known to be present. By default, the software runs 
the Poll phase every 3 minutes, which can be modified in the 
iomgr.ini file on the server.

During this phase, the Adaptec CI/O Management Software 
performs the following steps:

– Verifies that the number of SCSI adapters is the same as in 
the Discovery phase

– Performs an inquiry on each SCSI adapter that already 
appears in the internal tables to ensure that the adapter is 
still responding

– Performs a device inquiry on each device in the internal 
tables to ensure that the device is still responding

– Verifies that the information obtained from the device 
matches previous information

■ Statistics—Collects I/O statistics. Adaptec CI/O Management 
Software collects read and write statistics from applicable 
devices. By default, the software runs the statistics phase every 
10 seconds, which can be modified in the iomgr.ini file on the 
server.

During this phase, the following are performed: 

– Iterates through all SCSI adapters and devices

– Gathers statistics for each SCSI adapter or device

❒
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Configuring Arrays and 
Spares
This chapter explains how to add and delete arrays and spares with 
the server console version or with the networked client version of 
the Adaptec CI/O Management Software. The menus and 
commands are the same for all supported versions of Windows.

You must know the Adaptec CI/O Management Software password 
to add and delete arrays and spares. See Chapter 8, Setting Security 
Options, for more information.

The following topics are explained in this chapter:

■ Creating an Array on page 4-4

■ Making an Array the First Virtual Device on page 4-10

■ Deleting an Array on page 4-12

■ Initializing an Array on page 4-13

■ Creating Dedicated Spares or a Spare Pool on page 4-15

■ Deleting a Spare on page 4-18

■ Managing Arrays on External RAID Controllers on page 4-19

Note: These features are available for PCI array controllers 
and Bridge array controllers only. They are not available for 
SCSI adapters.
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Starting the Program
Follow these steps to start the Adaptec CI/O Management Software 
and prepare to configure arrays and spares. This assumes that the 
software is already installed and that communications have been 
established between the server and the networked clients or other 
consoles:

1 Start Windows.

2 Double-click the  icon in the Adaptec CI/O 
Management Software group to start the program.

Note: If you are running Adaptec CI/O Management 
Software from a networked client and the message 
Guest Access Disabled appears at this point, the 
server to which you are trying to connect does not 
allow remote users to view its configuration 
information. See Controlling Guest Access on page 8-4 
for more information.

3 Open the Server View window by clicking the button 
on the toolbar.

Note: If no Server icons appear in the upper part of the 
window, enter information about the servers you want 
to monitor before you continue. See Adding a New 
Server Address on page 2-1 for more information.
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4 Click the icon of the server whose arrays and spares you want 
to configure, as shown in Figure 4-1. You can identify the 
server by the name that appears beneath it.

If the icon appears dimmed, the server is off-line or otherwise 
unavailable. (See Entering and Viewing Server Information on 
page 2-1 for more information about server icons.)

5 Open the Storage Configuration window by clicking the

 icon on the toolbar. All array and spare configuration 
tasks are done from within this window.

Note: Depending on your system configuration, the 
Storage Configuration window may open 
automatically when you start the Adaptec CI/O 
Management Software. See the How-To Topics section 
of the Adaptec CI/O Management Software online 
Help for more information about this window.

You can open other Storage Configuration windows for other 
servers to which you are connected. To do this, return to the Server 

View window, select a different Server icon, and click the  
button again.

Figure 4-1. Server Icons
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Creating an Array
Follow these steps to create arrays with Adaptec CI/O Management 
Software:

1 Start Adaptec CI/O Management Software and open the 
Storage Configuration window, as described in Starting the 
Program on page 4-2. This window looks similar to the one 
shown in Figure 4-2.

The icons on the left side of the Storage Configuration window 
represent the server’s physical resources—the Adaptec RAID 
products, AIC-78xx products, channels, and SCSI devices 
installed in the server. The icons on the right side represent the 
server’s array resources—the arrays and spares you define. You 
click the buttons in the middle of the window to perform 
operations on selected Device icons.

2 Before you start defining the new array, decide what RAID 
level you want to use, how many disks you want it to have, 
and whether you want to define dedicated spares (spares that 
can be used only by this array). The following table lists your 
Array options. See Selecting a RAID Level for an Array on 
page 9-7 for information on the advantages and disadvantages 
of each RAID level.

Figure 4-2. Storage Configuration Window
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3 Select disks for the new array by clicking Disk icons that 
have the word Single beneath them, as shown in Figure 4-3.

Do not include disks that you want to use as dedicated spares. 
Click a second time on an icon to deselect it, or click the Clear 

RAID Level
Minimum 

Disks 
Maximum 

Disks 1
Dedicated 

Spares
Pool 

Spares 2

RAID 0 (Striped) 13 16 None None

RAID 1 (Mirrored) 2 2 1 or 24 up to 8

RAID 0/1 
(Mirrored & 
Striped)5

4 16 1 or 2 up to 8

RAID 5 (Striped, 
with Distributed 
Parity)

3 16 1 or 2 up to 8

1 This is the maximum number of disks supported by the software driv-
er. The maximum for your computer system may be less, depending 
on how many SCSI channels and devices you have.

2 Pool spares are not supported on bridge controllers.
3 The purpose of one-disk RAID 0 arrays is to give you more control 

over the virtual device order of disks controlled by the Adaptec RAID 
product. This is also useful for defining the system’s boot device.

4 Bridge controllers support up to 4 dedicated spares.
5 RAID 0/1 arrays must have an even number of disks.

Figure 4-3. Selecting Array Members
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Selection button to deselect all disk icons. All array disks must 
be connected to the same Adaptec RAID product.

Note: Only devices attached to array adapters and 
external RAID controllers can be used for arrays and 
spares. Devices attached to SCSI adapters can only be 
viewed.

A warning appears if you select a disk that has a partition. If 
the operating system recognizes the partition, you cannot use 
the disk in the array. If the operating system does not recognize 
the partition (for example, if the disk was previously 
partitioned under another operating system), you can use the 
disk in the array.

You cannot use disks with recognized partitions for the array 
so you will not accidentally erase the server’s boot disk. To 

find out if a disk has a partition, double-click the icon 
and click Check Partitions in the SCSI Information dialog 
box1. A small popup box indicates whether the selected disk 
has a partition and whether the partition is visible to the 
operating system. To use a disk with a recognized partition in 
the array, exit from Adaptec CI/O Management Software, back 
up any data you want to keep, and delete the partition from 
the disk.

Caution: All data on a disk is deleted when it becomes an 
array member! Back up any data you want to keep 
before selecting a disk as an array member.

1 The Check Partitions feature is not supported for arrays connected to bridge 
controllers.

!
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4 Click Create Array.... The Create Array dialog box appears, as 
shown in Figure 4-4.

The number of disks in the array and the array capacity are 
listed on the right of the dialog box.

5 Type a name for the new array. The name can be up to 15 
characters, including spaces and any other printable 
characters.

6 Select a RAID level for the array by clicking one of the buttons 
on the left. The bar graphs on the right show the relative levels 
of data protection, read performance, write performance, and 
capacity utilization for each RAID level.

RAID levels appear dimmed if they are not consistent with the 
number of disks you have selected. (See the table on page 4-5.) 
For example, RAID 0/1 appears dimmed if you selected three 
disks, because a RAID 0/1 array must have at least four disks.

7 Select one or two disks from the list as dedicated spares1. (Use 
Ctrl-Click to select multiple disks.) The disks on the list are the 
single disks you did not select as array members. The spare(s) 
you select should be at least as large as the smallest array 

1 Arrays connected to bridge controllers can have up to four dedicated spares 
each.

Figure 4-4. Create Array Dialog Box
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member. Otherwise the usable capacity of each array member 
will be reduced to the capacity of the spare.

Note: We recommend using a spare pool instead of 
dedicated spares1. See Creating Dedicated Spares or a 
Spare Pool on page 4-15 for more information. Spares 
in a spare pool can be used by any array on the 
controller.

8 Click Advanced... to examine or change the Advanced Array 
options. The Advanced Array Options dialog box appears. See 
Setting Advanced Array Options on page 4-9 for more 
information.

9 Click OK and then click Yes to confirm that you want to create 
the array. If error messages appear, indicating that your array 
selections are inconsistent, change your selections and click 
OK again. A warning appears if you selected a dedicated spare 
that is smaller than the array members.

The array is initialized at this point, unless you deselected 
auto-initialize in Advanced Array options. (If you deselected 
auto-initialize, skip to 11.) To abort the initialization process 
(not recommended), open the Array Activity Monitor window, 

select the icon for that array, and click Abort.

10 Wait until the new array is initialized. A popup box will 
appear to inform you that event notifications are waiting and 
can be viewed in the Server View window. Then an icon like

this for the new array appears in the right section of 
the Storage Configuration window. Another event notification 
is generated when the initialization process finishes.

1 Bridge controllers do not support spare pools.
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Note: Event notifications may appear as popups or as 
entries in the Server Historic Event Log and Event 
Log, depending on the Event Notification options you 
selected in the Client Settings dialog box.

11 Exit from Adaptec CI/O Management Software. Then reboot 
the server. (You cannot use the new array until you reboot.) 
You must partition the new array using the Windows NT Disk 
Administrator, just as you would partition a new stand-alone 
disk drive.

Setting Advanced Array Options
The Advanced Array Options dialog box is shown in Figure 4-5. Do 
not change these options from their default settings unless you have 
a specific reason to change them.

Here is a brief description of the advanced options:

■ Stripe size is the size that will be used to stripe data or parity 
information across the disks in the array. The optimal stripe 
size depends on factors such as the type of data being stored 
on the array and the server operating system. The default 
stripe size of 64 KBytes works best in most cases.

■ Deselect auto-initialize to create the array now but initialize it 
at a later time. You can do this to define several arrays, then 
initialize them all at the same time. 

Figure 4-5. Advanced Array Options Dialog Box
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Caution: All arrays except RAID 0 arrays must be 
initialized or low-level formatted before you can write 
data to them. We recommend that you zero-initialize 
RAID 0 arrays as well.

■ Click Restore Defaults to restore the default Advanced Array 
Options settings.

Note: The default settings are the settings that existed when 
you opened the dialog box. If you change the settings and 
click OK, these become the new default settings for this 
array.

Making an Array the First Virtual Device
Use this command if you want the server to boot from an array 
instead of from a stand-alone disk.1 (To use a stand-alone SCSI disk 
as your boot device, we recommend that you assign SCSI ID 0 to this 
device and that you connect it to Channel A of the Adaptec RAID 
product.)

You make an array bootable by assigning it virtual device order #0. 
The virtual device order is the sequence in which the server’s 
operating system detects the arrays, single disks, and other devices 
connected to the Adaptec RAID product when the server boots. You 
may also need to move the Adaptec RAID product to a different PCI 
slot. See your Adaptec RAID product’s Installation and Hardware 
Guide for more information.

Caution: When you make an array bootable, the drive letters 
assigned to other drives and arrays on the server may 
change, which can cause data access problems on your 
system.

1 Bridge controllers do not support this feature.

!

!
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Follow these steps to create a bootable array:

1 Start Adaptec CI/O Management Software and open the 
Storage Configuration window, as described in Starting the 
Program on page 4-2

2 Click the icon in the right part of the window for the 
array that you want to make bootable.

3 Click Operations.

4 Click .

5 When the message appears, click OK to confirm that you want 
to make this array the boot device.

6 Exit from the Adaptec CI/O Management Software. If the 
selected array does not already have a bootable partition on it, 
reboot the server to a floppy disk.

7 Install the operating system on the array. See your Adaptec 
RAID product’s Installation and Hardware Guide for more 
information.

The next time you boot the server, it will attempt to use this array as 
the boot device.
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Deleting an Array

Caution: Back up the data on an array before you delete it. 
All data on the array disks is lost when you delete the array. 

If you delete an array, all the disks that were part of the array 
become single, stand-alone disks. You can then use the disks as spares 
or as members of a new array. 

Follow these steps to delete an array:

1 Start Adaptec CI/O Management Software and open the 
Storage Configuration window, as described in Starting the 
Program on page 4-2.

2 Click the icon in the right area of the window for the 
array you want to delete.

3 Click Operations.

4 When the Array Operations dialog box appears, click

 to delete the array.

A warning appears if the selected array has a partition. If the 
partition is recognized by the operating system, you cannot 
delete the array. If the partition is not recognized by the 
operating system, you can delete the array.

You are prevented from deleting an array with a recognized 
partition so you will not accidentally delete the server’s boot 
array. To find out if an array has a partition, double-click the 

icon and click Check Partitions in the Array 
Information dialog box.1 A small popup box indicates whether 
the selected array has a partition and whether the partition is 
visible to the operating system.To delete an array with a 

1 The Check Partitions feature is not supported for arrays connected to bridge 
controllers.

!
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recognized partition, exit from Adaptec CI/O Management 
Software, back up any data you want to keep, and delete the 
partition from the disk. Then start Adaptec CI/O Management 
Software again and delete the array.

5 When the confirmation message appears, click OK to confirm 
that you want to delete the array.

Note: After you delete an array you can immediately use the 
disks that formerly belonged to the array to create spares or 
a new array without rebooting the server. However, you 
must reboot the server before you can use the disks as single 
disks that are not members of an array. Deleting an array 
may change the boot order and the drive assignment.

Initializing an Array
When you create a new array it is initialized immediately by default 
unless you deselect the auto-initialize option, as described on 
page 4-9. If you deselect auto-initialize, you can initialize the array 
later by following the instructions in this section1. You can also 
reinitialize an array that was previously zero-initialized or low-level 
formatted.

Caution: All arrays except RAID 0 arrays must be initialized 
or formatted before you can write data to them. We 
recommend that you zero-initialize RAID 0 arrays as well. 
All data on the disks is overwritten when you initialize an 
array.

Use the ArrayConfigSA™ program if you want to low-level format 
the array instead of initializing it with zeros2. Low-level formatting 
checks the surface of the disks for defects. See Appendix C, Using the 
ArrayConfigSA Initial Boot Array Installation Utility. 

1 Arrays connected to external array controllers (bridge controllers) are 
automatically initialized when they are created. You cannot defer the 
initialization until a later time.

2 ArrayConfigSA is not supported for arrays on bridge adapters. See the 
bridge adapter Installation Guide for more information.

!
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Follow these steps to initialize an array to which data has previously 
been written or a new array that has been defined but not initialized:

1 Start Adaptec CI/O Management Software and open the 
Storage Configuration window, as described in Starting the 
Program on page 4-2.

2 Click the icon of the array you want to initialize. The 
Operations button becomes active.

3 Click Operations.

4 When the Array Operations window appears, click the

button.

A warning appears if the selected array has a partition. If the 
partition is recognized by the operating system, you cannot 
initialize the array. If the partition is not recognized by the 
operating system, you can initialize the array.

You are prevented from initializing an array with a recognized 
partition so you will not accidentally erase the server’s boot 
array. To find out if an array has a partition, double-click the 

icon, and click Check Partitions in the Array 
Information dialog box.1 A small popup box indicates whether 
the selected array has a partition and whether the partition is 
visible to the operating system. To initialize an array with a 
recognized partition, exit from Adaptec CI/O Management 
Software, back up any data you want to keep, and delete the 
partition from the disk. Then start Adaptec CI/O Management 
Software again and initialize the array.

5 When the confirmation message appears, click Initialize to 
confirm that you want to initialize the array.

1 The Check Partitions feature is not supported for arrays connected to bridge 
controllers.
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To abort the initialization process (not recommended), open 

the Array Activity Monitor window, select the icon, 
and click Abort.

It may take a long time to initialize an array. You can watch the 
progress of the initialization process in the Array Activity Monitor 
window.

Creating Dedicated Spares or a Spare Pool
Each RAID 1, 0/1, or 5 array can have one or two dedicated spares, 
which automatically replace failed disks only for that array1. You can 
create dedicated spares when you create the array, or you can add 
them to the array at a later time. Each Adaptec RAID product can 
have a spare pool of multiple disks which automatically replace failed 
disks on any array on the Adaptec RAID product2.

We recommend using a spare pool instead of dedicated spares if you 
have two or more arrays on an Adaptec RAID product. Spare pools 
give you more flexibility and provide good data protection with 
fewer disks than is required for dedicated spares.

Note: Adaptec CI/O Management Software is automatically 
configured to test all spares on the server once a day to 
assure they are always available to replace failed disks in 
arrays. We recommend that you not change this default 
setting.

Follow these steps to add a dedicated spare or a pool spare:

1 Start Adaptec CI/O Management Software and open the 
Storage Configuration window, as described in Starting the 
Program on page 4-2.

2 Select the disk you want to configure as a spare by clicking on 
its icon in the left part of the window. (Choose a disk that has 
the word Single beneath it.)

1 Arrays connected to bridge controllers can have up to four dedicated spares 
each.

2 Bridge controllers do not support spare pools.
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3 Click Create Spare... The Create Spare dialog box appears, as 
shown in Figure 4-6. A list of already-defined spares appear on 
the right. Names of existing arrays appear on the left only if the 
disk you selected is large enough to protect that array as a 
spare.

Note: In the Storage Configuration window, pool 
spares are labeled p-spare and dedicated spares are 
labeled d-spare in both the left and right parts of the 
window.

4 If you want to dedicate the spare to a specific array, select 
Dedicated To and click the array name in the scrollable list. If 
you want to add the spare to the pool of spares available to all 
arrays on the controller, do not select the Dedicated To box.

5 Click OK to create the spare. A warning message appears if 
you select a disk that has a partition. If the partition is 
recognized by the operating system, you cannot use the disk as 
a spare. If the partition is not recognized by the operating 
system (for example, if the disk was previously partitioned 
under another operating system), you can use the disk as a 
spare.

You are prevented from using disks with recognized partitions 
so you will not accidentally erase the server’s boot disk. To 

Figure 4-6. Create Spare Dialog Box
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find out if a disk has a partition, double-click the icon 
and click Check Partitions in the SCSI Information dialog 
box1. A small popup box indicates whether the selected disk 
has a partition and whether the partition is visible to the 
operating system. To use a disk with a recognized partition as a 
spare, exit from Adaptec CI/O Management Software, back up 
any data you want to keep, and delete the partition from the 
disk.

Newly-created spares are immediately available for use, 
without rebooting the server. If an array is in Critical status, it 
will be reconstructed as soon as you have created the spare 
(unless the spare is dedicated to another array).

Note: You can add a disk of any size to the spare pool, 
even if the disk is too small to protect the existing 
arrays. For example, if you have created two arrays 
with 1 GByte disks, you can add a 500-MByte disk to 
the spare pool, even though this disk is too small to 
replace any failed array member. This allows you to 
create a third array later with 500-MByte disks, for 
example.

To see which arrays are protected by an existing spare, select the 
spare in the Existing Spares list; the arrays protected by this spare 
are highlighted in the Existing Arrays list. You can double-click an 
array or a spare to view detailed information about it.

1 The Check Partitions feature is not supported for arrays connected to bridge 
controllers.
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Deleting a Spare
Follow these steps to delete a spare to use it as a stand-alone disk:

1 Start Adaptec CI/O Management Software and open the 
Storage Configuration window, as described in Starting the 
Program on page 4-2.

2 Click the icon in the Array part of the window for the spare 
you want to delete. The icons for dedicated spares are labeled 
“d-spare” and the icons for pool spares are labeled “p-spare.”

3 Click Operations

4 When the Spare Operations dialog box appears, click the 
Delete button.

5 When the confirmation message appears, click OK to confirm 
that you want to delete the spare.

After you delete an existing spare, and before you reboot the server, 
you can use a former spare to create a new array or spare. However, 
this disk does not become visible to the server operating system as a 
single disk until after you reboot the server.

For information on replacing a spare disk, see Replacing a Spare on 
page 9-3.
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Managing Arrays on External RAID Controllers
A bridge controller connects Fibre Channel-to-SCSI or SCSI-to-SCSI 
external intelligent RAID array controllers to bridge the host I/O 
interface to multiple back-end device channels. These devices 
appear under a SCSI channel, but are capable of the same 
functionality as SCSI devices connected to array controllers (see 
Figure 4-7 below). Refer to the sections on configuring and viewing 
arrays in this User’s Guide for specific information on arrays.

Figure 4-7. Arrays from External RAID Controller

❒
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Viewing Array and Device 
Information
The Adaptec CI/O Management Software allows you to view 
information about arrays, spares, and SCSI devices on any server to 
which you have access. You view this information in the Storage 
Configuration window. Follow these steps to open the Storage 
Configuration window:

1 Select Configuration from the View menu, or click the  
icon on the toolbar.

2 When the Storage Configuration window appears, double-
click the icon that represents the device for which you want to 
view information. Refer to Figure 5-1.

Logical 
Devices

Physical 
Devices

Adaptec 
RAID 
product

Disk Device

CD-ROM 
Drive

Array

Spare

Figure 5-1. Storage Configuration Icons

Other Physical 
Devices...
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The Array and Spare icons are “logical” devices that appear on 
the right side of the Storage Configuration window. Logical 
means that arrays and spares do not exist until you configure 
them on the server.

The Product, Channel, and SCSI device icons are physical 
devices that appear on the left side of the window. Physical 
means that the icons correspond to actual devices installed in 
the server, such as a SCSI drive or a CD-ROM drive.

The following sections explain the information that appears when 
you click an icon for a logical or physical device.

Viewing Array Information

When you double-click an Array icon  in the Storage 
Configuration window, the Array Information dialog box appears, 
as shown in Figure 5-2.

The following information appears in the Array Information dialog 
box:

■ Status: current status of the array, such as OK, Off-line, Fault-
tolerant, Critical, etc.

Figure 5-2. Array Information Dialog Box
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■ Model: model name of the Adaptec product to which the array 
disks are connected.

■ Array type: RAID level of the array. The supported levels are 
RAID 0, RAID 1, RAID 0/1, and RAID 5.

■ Capacity: total usable disk space available in the array, in 
MBytes.

■ Member size: size of the array members.

■ Array members: number of disks in the array.

■ Dedicated spares: number of spare disks dedicated to this 
array.

■ Available pool spares: number of pool spares available to 
protect this array.

Click Check Partitions. A small dialog box indicates whether the 
selected array has a partition and whether the partition is visible to 
the operating system.

When you click Detail, you can view the following additional 
information about the array:

■ Stripe size: data and parity striping size used on this array.

■ Virtual device order: the sequence in which the server’s 
operating system detects this array when it boots. If the array’s 
virtual device order is 0, then this array is the first device the 
operating system detects at boot time.

■ Creation date: date on which the array was created.

■ Date of last verify: date on which the array was last verified. 
See Verifying Array Integrity on page 6-7 for information on 
how to verify an array.

■ Date of last reconstruct: date on which the array was last 
reconstructed. See Reconstructing an Array on page 6-2 for 
information on how to reconstruct an array.

Click Close to close the Array Detail and Array Information dialog 
boxes.
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Viewing Spare Information

When you double-click a Spare icon in the right side of the 
Storage Configuration window the Spare Information dialog box 
appears, as shown in Figure 5-3.

When you double-click a Spare icon in the left side of the window, 
the SCSI Information dialog box appears, as it does for a single SCSI 
disk.

The Spare Information dialog box shows which array the spare is 
dedicated to, whether it is a member of a spare pool, its capacity, and 
its current status. An Available status means the spare is fully 
functional and is available to replace a failed array disk.

Note: The Spare icons in the Storage Configuration window 
are labeled p-spare for pool spares and d-spare for 
dedicated spares.

Click Close to close the Spare Information dialog box or SCSI 
Information dialog box.

Figure 5-3. Spare Information Dialog Box
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Viewing SCSI Device Information from an Array 
Controller
SCSI devices can be connected to array controllers as well as to SCSI 
adapters. The same SCSI device information is provided in both 
cases. See Viewing the SCSI Information Dialog Box on page 3-4 for a 
description of the SCSI Information Dialog Box. 

Note: You cannot use a disk in an array if it has a partition 
that is visible to the operating system. (This prevents you 
from accidentally deleting data or erasing your boot disk.) 
To use a disk with a recognized partition in the array, exit 
from the Adaptec CI/O Management Software program, 
back up any data you want to keep, delete the partition, and 
then run the program again.

Rescanning the Server
Whenever you boot the server, the operating system software scans 
the server for installed devices such as arrays and SCSI devices. 
Adaptec CI/O Management Software displays icons for these 
devices in the Storage Configuration window.

You may need to issue a Rescan command while Adaptec CI/O 
Management Software is running so it can “see” the new hardware 
configuration. You need to do a rescan if

■ You connect a new SCSI device to the Adaptec RAID product 
without using the Pause I/O command

■ You disconnect a SCSI device from the Adaptec RAID product 
without using the Pause I/O command

A rescan is done automatically whenever you pause I/O and 
resume I/O to an array or a device. You do not need to issue a 
Rescan command to detect a failed array member. Adaptec CI/O 
Management Software will detect the failed member automatically 
if I/O is occurring on the array.
5-5



Adaptec CI/O Management Software User’s Guide
Follow these steps to rescan the server:

1 Click the  button on the toolbar. The Storage 
Configuration window appears.

2 Click Rescan in the area between the Physical Resources and 
Array areas of the window.

3 When the message appears, click Yes to confirm that you want 
to rescan the server. When the rescan is complete, any 
hardware changes are reflected in the icons in the Storage 
Configuration window.

4 Click OK when the message appears indicating that the rescan 
was completed successfully.

Note: You cannot use the Rescan command to recognize an 
entire array that was transferred from another server. You 
must reboot the server before it recognizes the transferred 
array. However, if you remove a disk that is an array 
member, replace it with another disk, and issue a Rescan 
command, Adaptec CI/O Management Software will detect 
that the new disk is no longer an array member.
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Viewing Array Controller Information
When you double-click an icon for an Adaptec RAID product 

, the Controller Information dialog box appears, as shown 
in Figure 5-4.

The information in the Controller Information dialog box is self-
explanatory. The PCI bus number field indicates which PCI slot the 
Adaptec RAID product is installed in. You may need this 
information to configure the server to boot from an array. For more 
information, read the server documentation.

Click Capabilities to view a list of the features supported by this 
Adaptec RAID product. The list is informational only; you cannot 
enable or disable the capabilities on the list. These are controller 
capabilities that may appear on the list (not all features appear for 
every product):

■ Auto Verify: indicates that the Adaptec RAID product 
automatically verifies SCSI parity.

■ Auto Fix: indicates that the Adaptec RAID product 
automatically corrects data and parity miscompares.

■ Supported RAID Levels: lists the RAID levels the Adaptec 
RAID product supports.

■ Maximum Number of Spares: lists the maximum number of 
dedicated spares per array that the Adaptec RAID product 
supports.

Figure 5-4. Controller Information Dialog Box
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■ Maximum Number of Physical Arrays: lists the maximum 
number of arrays the Adaptec RAID product supports.

■ Maximum Number of Drives for a Single Array: lists the 
maximum number of disks the Adaptec RAID product 
supports for a single array.

■ Maximum/Minimum Stripe Size: lists the range of data and 
parity stripe sizes that the Adaptec RAID product supports.

■ Spare Pool: indicates that the Adaptec RAID product supports 
using spares from a spare pool.

Click Close to close the Capabilities dialog box and the Controller 
Information dialog box.
5-8



Viewing Array and Device Information
Viewing Channel Information

When you double-click a Channel icon , the Channel 
Information dialog box appears, as shown in Figure 5-5.

The following information appears in the Channel Information 
dialog box:

■ Status: current operational status of the channel (for example, 
Active, Inactive).

■ Channel Type: type of this channel—for example, SCSI.

■ Maximum Devices: maximum number of SCSI devices that 
the channel supports. For example, if this number is 16, you 
can connect up to 15 devices, since the channel itself counts as 
one device.

■ Current Devices: number of SCSI devices currently connected 
to the channel.

Click Close to close the Channel Information dialog box.

❒

Figure 5-5. Channel Information Dialog Box
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Performing Array, Spare, 
and Disk Operations
In Adaptec CI/O Management Software you can perform a number 
of operations on arrays, spares, and stand-alone disks. These 
operations include verifying the parity of arrays, reconstructing an 
array, testing spares, and blinking the lights on one or more disks. 
Some of the operations are performed immediately; others can be 
scheduled for a later time, or scheduled to occur periodically at 
stated intervals.

To perform array, spare, and disk operations: 

1 Select Configuration from the View menu, or click the 

icon on the toolbar.

2 When the Storage Configuration window appears, single-click

the icon that represents the array , spare , or SCSI

disk you want to work on.

When you do this, the Operations button becomes active. 

3 Click Operations. The Array Operations, Spare Operations, or 
Disk Operations dialog box appears.
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4 Click the button for the operation you want to perform. See the 
appropriate section of this chapter for a description of these 
operations.

Performing Array Operations
A list of the array operations follows. Note that some of these 
operations are described in Chapter 4, Configuring Arrays and Spares.

■ Reconstructing an Array on page 6-2

■ Pausing I/O on an Array on page 6-5

■ Verifying Array Integrity on page 6-7

■ Blinking Array Drive Lights on page 6-9

■ Reactivating an Off-line Array on page 6-10

■ Changing an Array Name on page 6-11

■ Forcing a Spare on page 6-11

■ Making an Array the First Virtual Device on page 4-10

■ Creating an Array on page 4-4

■ Initializing an Array on page 4-13

Reconstructing an Array
If a spare disk is available when an array disk fails, the array is 
automatically reconstructed, and you do not need to use the 
Reconstruct operation. However, if a disk in an array fails and no 
spare is available to replace it, you receive an event notification that 
the array is Critical. You may need to reconstruct the array with this 
command after the drive is replaced. In either case, data on the array 
is not lost.

You can reconstruct an array immediately after you replace the 
failed disk, or you can schedule the reconstruct to occur at a later 
time. Since the reconstruction process may take a long time, you 
may want to schedule it for a time when there is less activity on the 
server.
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Note: The Verify operation can take up to several hours for a 
large array.

Follow these steps to reconstruct an array when a disk fails:

1 Determine which array is in Critical status and which disk in 
the array has failed.

It is possible that a RAID 0/1 array in Critical status may have 
more than one failed disk. The array can still be reconstructed 
without data loss as long as at least one disk of each mirrored 
pair is still good.

2 If the array enclosure does not support hot swapping1, pause 
I/O to the array. (See Pausing I/O on an Array on page 6-5.) This 
is not necessary if the array enclosure does support hot 
swapping.

3 Replace the failed disk (or disks) with a good disk of at least 
the same storage capacity. Be sure that the SCSI ID of the new 
disk is different from the SCSI ID of other installed devices. Or, 
if an array disk was accidentally disconnected, reconnect it.

4 If you paused I/O in Step 2, wait until it automatically 
resumes after the pause period. If you did not pause I/O, issue 
a Rescan command to detect the new disk.

5 If you installed a new disk (or disks), make the disk into a 
spare by following the directions in Creating Dedicated Spares or 
a Spare Pool on page 4-15. Be sure the new spare disk is at least 
as large as the smallest array member.

Note: When the spare is created, Adaptec CI/O 
Management Software should automatically start a 
Reconstruct operation on the array. If for some reason 
the reconstruct does not begin automatically, follow 
the remaining steps to perform it manually.

1 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad drive is replaced.
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6 Select Configuration from the View menu. The Storage 
Configuration window appears.

7 Click on the Array icon that looks like this . The 
Operations button becomes active.

8 Click Operations. The Array Operations dialog box appears, 
as shown in Figure 6-1.

9 Click the button. If the array has one failed drive the 
Scheduler dialog box appears.

If you have a RAID 0/1 array with two or more failed disks, 
and at least one disk of each mirrored pair is still good, a dialog 
box appears with a list of the failed drives. You must 
reconstruct the disks one-at-a-time, starting over each time at 
the beginning of these steps. Select one of the drives on the list 
and click OK; the Scheduler dialog box appears. (This assumes 
that you have already physically replaced all of the failed 
drives with good drives.)

10 Enter the required information for the Reconstruct operation in 
the Scheduler dialog box. You can select Immediate to 
reconstruct the drive immediately or select Once to schedule 
the operation for a later time. (See Setting Scheduling Options on 
page 7-1 for more information.)

Figure 6-1. Array Operations Dialog Box
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11 Select an Execution priority - high, medium, or low.

12 Click OK.

13 When the message appears, confirm that you want to 
reconstruct the array member.

14 Read the event notifications that appear in the Server View 
window (they may also appear as popups on the screen) to 
determine when the reconstruct is complete.

Open a Watch box if you want to monitor the progress of the array 
reconstruction. (See Monitoring Activities That Are Running on 
page 7-6.)

Pausing I/O on an Array
Use this option to temporarily stop I/O transactions on the SCSI bus 
while you replace a disk or reconnect a loose connection in an array 
enclosure that does not support hot swapping1. If your array 
enclosure supports hot swapping, you probably do not need to 
pause I/O to replace a disk. See the array enclosure documentation 
for more information.

When you pause an array, all other devices on all channels on the 
Adaptec RAID product are also paused. I/O is automatically 
resumed after a specified pause interval.

Caution: Pause I/O cannot assure the same level of 
protection from electrical noise that you have when you 
replace a disk in an enclosure that supports hot swapping. 
Every time you use this feature, you should only perform 
one action—either disconnecting a drive or inserting a 
drive, but not both. Do not replace a non-downed drive in a 
paused array, as this may cause data to be corrupted. 
Instead, down the drive first and then replace it.

1 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad disk is replaced.

!
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Follow these steps to pause and resume I/O on an array:

1 Open the Storage Configuration window and select the icon of 

the array you want to pause.

2 When the Array Operations dialog box appears, click the

button.

3 When the Pause I/O dialog box appears, enter a pause interval 
that does not exceed the maximum allowable pause period, 
and click OK to pause the array.

Note: The Minimum pause period is 5 seconds; the 
maximum pause period is 120 seconds. The Pause I/O 
command is disabled if a Verify, Reconstruct, or 
Initialize operation is running.

4 Remove or replace the disk drive, as required. Data I/O 
resumes automatically at the end of the pause period.

Caution: You must replace the device with the same 
kind of SCSI device. You should not, for example, 
replace a disk drive with a CD-ROM drive while I/O 
is paused.

!
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Verifying Array Integrity
Use this option to verify the integrity of redundant data stored on 
fault-tolerant (RAID 0/1, RAID 1, RAID 5) arrays. When you run 
this operation, Adaptec CI/O Management Software checks the 
array for miscompares and corrects parity errors automatically. A 
miscompare occurs when the parity information on a RAID 5 array 
does not match the user data or when some part of the data on a 
mirrored disk pair in a RAID 0/1 or RAID 1 array does not match.

In Adaptec CI/O Management Software you can schedule the Verify 
operation to run later or schedule it to run at a regularly occurring 
interval. We recommend that you schedule a verification of all 
arrays at least once a week. See Setting Scheduling Options on 
page 7-1 for more information.

Caution: You should run the Verify operation immediately 
on all fault-tolerant arrays after any kind of system failure, 
including a disorderly system shutdown. A failed drive in 
an array cannot be reconstructed if the data is inconsistent.

Follow these steps to verify the integrity of redundant array data:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Click on the Array icon . The Operations button 
becomes active.

3 Click the Operations button.

!
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4 When the Array Operations dialog box appears, click the

 button to verify the data on the array. The Scheduler 
dialog box appears, as shown in Figure 6-2.

5 Leave the autocorrect box checked so that any data parity or 
mirroring mismatches will be corrected automatically.

6 Select Immediate if you want to verify parity immediately, or 
select Scheduled if you want to schedule the operation for a 
future time.

Figure 6-2. Scheduler Dialog Box
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7 If you select Scheduled, enter a start time, start day of the 
week, and other information. (See Setting Scheduling Options on 
page 7-1 for more information.)

8 Select an Execution Priority - high, medium, or low. This sets 
the system resources devoted to the operation. A high priority 
for the Verify operation requires a lot of system resources, 
which may slow down other system activity.

9 Click OK to start the operation (if you selected Immediate) or 
to enter it on the list of scheduled activities.

10 When the message appears, confirm that you want to verify 
parity information.

Note: The Verify operation can take up to several hours for a 
large array.

You can open a Watch window to monitor the progress of the 
operation as it is running. See Monitoring Activities That Are Running 
on page 7-6 for more information.

Blinking Array Drive Lights
You can issue a command to blink the drive lights of all the disks in 
a selected array. This allows you to see which physical drives 
actually form the array.

Note: Adaptec CI/O Management Software does not 
support blinking the drive lights on CD-ROM drives.

Follow these steps to blink the drive lights of the disks in an array:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Click on an Array icon in the right side of the dialog box. The 
Operations button becomes active.

3 Click the Operations button.
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4 When the Array Operations dialog box appears, click the

 button.

5 Look at the array enclosure to see which disks are members of 
the array.

6 Click the Unblink all button in the Storage Configuration 
dialog box to stop the drive lights from blinking.

Reactivating an Off-line Array
An array may go off-line because a cable is disconnected or because 
you mistakenly remove the wrong disk while trying to replace a 
failed disk. In these situations, the array shuts down temporarily. 
Depending on the reason that the array went off-line, it is possible to 
reactivate it and resume I/O without data loss. See Responding to an 
Off-Line Array on page 9-5 for more information.

After you correct any hardware problems, follow these steps to 
reactivate an off-line array:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Click on the dimmed icon of the off-line array. The Operations 
button becomes active.

3 Click Operations.

4 When the Array Operations dialog box appears, click the

 button.

5 When the message appears, confirm that you want to 
reactivate the array. Be sure that any hardware problems are 
corrected before you do this.
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Changing an Array Name
When you create an array, you assign it a name. This name appears 
beneath the Array icon and in many of the windows and dialog 
boxes. It is also used to identify the source of event notifications. You 
can change this name at a later time.

Follow these steps to change the name of an existing array:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Click the icon of the array whose name you want to 
change. The Operations button becomes active.

3 Click Operations.

4 When the Array Operations dialog box appears, click the

 button. The Change Name dialog box appears.

5 Type the new array name and click OK.

6 When the confirmation message appears, confirm that you 
want to change the array name. This change appears 
immediately in the Storage Configuration window.

Forcing a Spare
Forcing a spare means issuing a command for a spare disk to replace 
a specific disk in an array. You can do this if the array disk is not 
performing well and has generated a S.M.A.R.T. predictive failure 
event notification1. (If an array member actually does fail, a spare 
replaces it automatically without requiring you to force a spare.)

1 S.M.A.R.T. stands for Self-Monitoring Analysis and Reporting Technology. 
Hard drives that support this technology continually analyze their 
performance and generate an alert if they determine that the disk is likely 
to fail in the next few hours. Adaptec CI/O Management Software 
generates an event notification if it receives this alert, allowing you to 
replace the disk before it actually fails.
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Follow these steps to force a spare:

1 Be sure that one or more spares are available for the array. 
These can either be dedicated spares for the array or spares 
from a spare pool. See Creating Dedicated Spares or a Spare Pool 
on page 4-15 for more information on configuring spares.

2 Select Configuration from the View menu. The Storage 
Configuration window appears.

3 Click on the icon of the array with the suspect disk. The 
Operations button becomes active.

4 Click Operations.

5 When the Array Operations dialog box appears, click the

 button. This button appears dimmed if no spares are 
available.

6 Select the disk that you want to replace.

7 Click OK to replace this disk with a spare.

8 When the confirmation message appears, confirm that you 
want to replace the disk with the spare.

At this point data I/O is paused to the disk, and the spare is 
automatically activated to replace it.

If there is a pool of available spares, you cannot control which disk 
from the pool is activated when you force a spare. You can control 
this if there is only one dedicated spare or one pool spare. If both 
dedicated spares and pool spares are available, the dedicated spares 
are used first. If an error message indicates that the pool spare is not 
at least as large as the smallest disk in the array, add a larger spare.
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Performing Spare Operations
The following are spare operations available in Adaptec CI/O 
Management Software.

■ Testing All Spares on page 6-13

■ Blinking the Spare Drive Light on page 6-14

■ Deleting a Spare on page 4-18

Note: All spare operations apply only to the spares on the 
currently selected server.

Testing All Spares
Reliable spares must be available to immediately (and 
automatically) replace any array disk that fails. Spares should be 
tested regularly to assure that they are working properly. We 
recommend that you test all spares daily. You can run this operation 
immediately by issuing a command, or you can use the Scheduler 
function to set up a recurring check of all the spares at a time when 
few, if any, users are logged on to the server.

Note: Adaptec CI/O Management Software automatically 
sets up a daily Test All Spares operation on the server. We 
recommend that you leave this default setting.

Follow these steps to test all spares:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Click the icon of any spare on the right side of the dialog box. 
The Operations button becomes active.

3 Click Operations.

4 When the Spare Operations dialog box appears, click the

 button. The Scheduler dialog box appears, as shown in 
Figure 6-2 on page 6-8.
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5 Select Immediate if you want to test all spares immediately, or 
select Scheduled if you want to schedule the operation for a 
later time.

6 If you select Scheduled, enter a starting time, starting day, and 
other information.

7 Select an Execution Priority - high, medium, or low.

8 Click OK to start the operation (if you selected Immediate) or 
to enter it on the list of scheduled activities.

9 When the confirmation message appears, confirm that you 
want to test the spares.

10 Read the pop-up message that appears when the test is 
completed. (The message is also recorded in the server Historic 
Event Log and the Server View window.) If any spares failed 
the test, look at the Spare Disk icons in the Storage 
Configuration window. The icons of the failed disks will look 

like this .

11 Replace any failed disks immediately with good disks of at 
least the same capacity.

Blinking the Spare Drive Light
You can issue a command to blink the drive light of a spare. This 
allows you to see which physical drive is the actual spare.

Follow these steps to blink the drive light of a spare:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Click a Spare icon in the right side of the dialog box. The 
Operations button becomes active.

3 Click Operations.

4 When the Spare Operations dialog box appears, click the

 button.

5 Look at the array enclosure to see which disk light is blinking.
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6 Click Unblink all in the Storage Configuration window to stop 
the drive light from blinking.

Performing Disk Operations
You can perform the following disk operations with a single disk or 
with a selected disk in an existing array:

■ Blinking the Drive Light on page 6-15

■ Downing the Drive on page 6-16

■ Pausing I/O to an Array Disk Drive on page 6-17

Blinking the Drive Light
You can issue a command to blink the light of a disk whose icon you 
have selected. This allows you to see which physical disk 
corresponds to the Disk icon.

Note: Adaptec CI/O Management Software does not 
support blinking the drive lights on CD-ROM drives.

Follow these steps to blink a drive light:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Click a Disk icon in the left side of the window. The Operations 
button becomes active.

3 Click Operations.

4 When the Drive Operations window appears, click the  
button.

5 Look at the array enclosure to see which disk light is blinking.

6 Click Unblink all in the Storage Configuration dialog box to 
stop the drive light from blinking.
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Downing the Drive
Use this option to stop all data I/O to a member of an array. You 
might need to use this option if the disk generates a S.M.A.R.T.1 alert 
indicating that it is about to fail. When you down an array member, 
a spare is activated immediately (if available) to replace it, and a 
reconstruct is triggered for RAID levels that support it.

Note: The Down a Drive command can be used only for 
array members, not for spare disks or single disks.

Follow these steps to down a disk:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Select the icon of the disk you want to pause.

3 Click Operations.

4 When the Drive Operations dialog box appears, click the

button. If a spare is available, it replaces the downed 
disk immediately and a reconstruct of the array is triggered.

5 Wait until the Reconstruct operation is complete, then continue 
with your work in the program.

For more information, see Replacing an Active Array Member on 
page 9-4.

1 S.M.A.R.T. stands for Self-Monitoring Analysis and Reporting Technology. 
Hard drives that support this technology continually analyze their 
performance and generate an alert if they determine that the disk is likely 
to fail in the next few hours. Adaptec CI/O Management Software 
generates an event notification if it receives this alert, allowing you to 
replace the disk before it actually fails.
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Pausing I/O to an Array Disk Drive
Use this option to pause data I/O on a disk drive that is connected 
to an Adaptec RAID product. You can use this option to replace the 
disk if the array enclosure does not support hot swapping1. See the 
array enclosure documentation for more information. When you 
pause I/O to a disk drive, all other devices connected to the Adaptec 
RAID product are paused as well. I/O resumes automatically at the 
end of the pause period.

Caution: Pause I/O cannot assure the same level of 
protection from electrical noise that you have when you 
replace a disk in an enclosure that supports hot swapping. 
Every time you use this feature, you should only perform 
one action—either disconnecting a drive or inserting a 
drive, but not both. Do not replace a non-downed drive in a 
paused array, as this may cause data to be corrupted. 
Instead, down the drive first and then replace it.

Follow these steps to pause data I/O to a disk drive:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Select the icon of the disk you want to pause.

3 Click Operations. When the Array Operations dialog box 

appears, click the  button.

4 When the Pause I/O dialog box appears, enter a pause interval 
that does not exceed the maximum allowable pause period, 
and click OK to pause the disk. (You may need to enter the 
server.)

1 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad drive is replaced.

!
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Note: The minimum pause period is 5 seconds; the 
maximum pause period is 120 seconds. The Pause I/O 
command is disabled if a Verify, Reconstruct, or 
Initialize operation is running.

5 Complete your work before the pause period expires. I/O 
resumes automatically at the end of this period.

Caution: You must replace a device with the same kind 
of SCSI device. You should not, for example, replace a 
disk drive with a CD-ROM drive while I/O is paused.

❒

!
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7▼  ▼  ▼  ▼
Scheduling and Monitoring 
Array Operations
Adaptec CI/O Management Software enables you to schedule 
certain kinds of operations to run at a later time, or to schedule them 
to run at regularly recurring intervals. You create these as scheduled 
jobs at the time you give the command to run the activity, as 
described in Verifying Array Integrity on page 6-7, Reconstructing an 
Array on page 6-2, and Testing All Spares on page 6-13.

Setting Scheduling Options
The Scheduler dialog box allows you to schedule the Reconstruct an 
Array, Verify Integrity of Array, and Test All Spares operations. 
Reconstruct an Array is a one-time event for which you can enter a 
date and time. Verify Integrity of Array and Test All Spares can be 
scheduled as hourly, daily, or monthly recurring events.

Caution: All scheduled activities must be deleted and 
rescheduled if you change the system time. Otherwise, the 
scheduled activities may not run at the specified time. Do 
not change the system time while Adaptec CI/O 
Management Software is running. Instead, stop all CI/O 
components and RPC modules, change the system time, and 
then restart CI/O.

!
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Follow these steps to set scheduling options for a newly added 
operation:

1 Define a new scheduled operation: Reconstruct an Array, 
Verify Integrity of Array, or Test All Spares. The Scheduler 
dialog box appears, as shown in Figure 7-1.

2 Select Immediate to perform the action immediately or 
Scheduled to schedule it for later.

3 If you select Scheduled, select Once, Periodically, Daily, or 
Weekly. Enter other information such as day of the week or 
start time/date, as required.

If you are scheduling an array reconstruct, you can only select 
the Once option.

Figure 7-1. Scheduler Dialog Box
7-2



Scheduling and Monitoring Array Operations
Note: If you schedule an activity from a remote client 
to occur on a server in a different time zone, the 
activity will occur at the stated time relative to the 
server’s time zone. For example, suppose you 
schedule an activity to occur at 11:00 P.M. on a server 
in a time zone that is three hours later than the remote 
client’s time zone. The activity will occur at 11:00 P.M. 
in the server’s time zone, which is 8:00 P.M. in the 
remote client’s time zone.

4 Click OK to record the scheduling options. You may be 
prompted to confirm the activity.

Viewing and Managing Scheduled Activities
You can view information about scheduled and currently running 
activities in the Array Activity Monitor window. You can abort 
activities that are running or delete scheduled activities. The Array 
Activity Monitor window shows scheduled tasks for the currently 
selected server. To view activities on another server, select the Server’s 
icon in the Server View window and open a new Array Activity 
Monitor window.

Note: Adaptec CI/O Management Software automatically 
sets up a daily Test All Spares operation on the server.
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Follow these steps to view and manage scheduled activities:

1 Select Activities from the View menu. The Array Activity 
Monitor window appears, as shown in Figure 7-2.

2 Select an Activity icon from the left part of the window. 
Information about the activity is shown in the window. Each 
kind of activity has a unique icon. The icon labels indicate 
which array or spare the activity applies to.

To view more detailed information about the activity, double-
click the Activity icon. The Scheduler dialog box appears, as 
shown in Figure 7-1. Click Cancel to close the dialog box.

3 To change the priority of a Verify or Reconstruct operation that 
is currently running (as indicated by a moving icon), select the 
activity icon on the left of the window and then click Change 
Priority. When the Change Priority dialog box appears, select 
an option and click OK.

Figure 7-2. Array Activity Monitor Window
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Note: The priority change applies only while the 
activity is running this time. If it is a regularly 
scheduled activity, the next time it runs it will have the 
priority originally assigned to it. You cannot change 
the priority of an Initialize or Test all Spares operation 
that is currently running.

4 To delete an activity that is not currently running, select its icon 
and click the Delete button. After you confirm the command, 
the activity is deleted from the list.

5 To abort a currently-running activity, select its icon and click 
the Abort button. After you confirm the command, the activity 
stops running immediately. If this is a regularly recurring 
activity, such as a nightly test of all spares, it will run again in 
the future at the next scheduled time. Use Abort and then 
Delete if you want the activity to never run again.

6 Click the Watch button to open a small window to monitor the 
selected, currently running activity. See the following section 
for more information.
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Monitoring Activities That Are Running
You can open one or more Watch windows to monitor currently-
running array activities. You can leave these small windows open 
while you continue doing other work on the computer.

When a Verify operation completes, the Watch window shows the 
total number of miscompares. A miscompare occurs when the parity 
information on a RAID 5 array does not match the user data or 
when some part of the data on a mirrored disk pair in a RAID 0/1 or 
RAID 1 array does not match. If you checked the Auto Fix box in the 
Verify dialog box, the miscompares are automatically fixed.

Follow these steps to monitor activities that are running:

1 Select Activities from the View menu. The Array Activity 
Monitor window appears.

2 Select the icon of a currently-running activity from the 
scrollable list at the top of the window.

3 Click Watch. A small Watch window for this activity appears, 
as shown in Figure 7-3. Each window has a percent complete 
graph and a Status field (OK or Failed). If a Verify operation is 
running, there is also a field listing the number of miscompares 
found. Click Close to close the Watch window after the activity 
has completed.

❒

Figure 7-3. Watch Window
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Setting Security Options
Adaptec CI/O Management Software provides simple but effective 
password protection to prevent unauthorized changes to array 
configuration. Users who know the password can view server 
information and can issue commands to add and delete arrays, add 
and delete spares, and make other changes to array configuration. 
Users who do not know the password can view server information 
but cannot change array configuration. The network administrator 
can disable the Guest Access feature (see page 8-4) for each server to 
prevent users who do not know the password from even viewing 
server information.

The network administrator sets the initial password for each server 
and controls users’ access to passwords.
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Changing the Password
The Server Manager allows you to change password from any client 
on the network. 

Follow these steps to change the Adaptec CI/O Management 
Software password:

1 Open the Server View window by clicking the  button. 
Then select the icon of the server whose password you want to 
change.

2 Select Server Administration from the View menu. Then select 
Change Password. The Change Password dialog box appears, 
as shown in Figure 8-1.

If you are installing a password for the first time, type the 
default password, “adaptec” in the Old Password field 
(password is case sensitive).

Note: It is a good idea to change from the default 
password as soon as possible, to prevent unauthorized 
users from entering the Adaptec CI/O Management 
Software program.

Figure 8-1. Change Password Dialog Box
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3 Type the new password in the New Password field.

Passwords are case sensitive and can be up to 16 characters 
long, including the characters A-Z, a-z, and 0-9. Spaces are not 
allowed. Long passwords with a mixture of numerals and 
letters provide better security. Do not use obvious passwords 
like your name, the name of a family member, your birthday, 
your social security number, etc.

4 Type the new password again in the Confirm Password field.

5 Click OK to accept the new password.

Setting Password Time-out Options
The Password Time-out options allow you to control the way in 
which users are prompted to enter the server’s Adaptec CI/O 
Management Software password when they issue commands to 
change a server’s array configuration. The Password Time-out 
options are set individually for each networked client.

Follow these steps to change the Password Time-out options:

1 Click the  button on the toolbar. The Preferences dialog 
box appears.

2 Select one of the three password time-out options listed on the 
right of the dialog box. Here is a description of the options:

– No Password Time-out: Requires you to enter the password 
only the first time (during each session) that you issue a 
command to change array configuration. This option 
provides somewhat less security than the others: if you 
leave your workstation unattended after entering the 
password, another person can issue commands from the 
workstation without being prompted for the password.

– Always Require Password: Requires you to re-enter the 
password every time you issue a command to change array 
configuration.

– Enter Password Time-out Interval: Requires you to re-enter 
the password at the stated time-out interval, whenever you 
issue commands to change the array configuration. For 
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example, suppose that the time-out interval is 10 minutes. 
You start the program at 9:00 and issue a command to create 
a new array on a server. You are prompted to enter the 
password before the command is accepted. After entering 
the password, you issue a command at 9:05 to add spares to 
the spare pool; no password is required. At 9:16 you issue a 
command to delete an array; since you are beyond the 10-
minute interval, you are prompted again to enter the 
password before the command is executed.

3 Click OK to accept the password time-out change. You may be 
required to enter the password in order to confirm the change.

Note: You must enter the password at least once after 
the application has started, or when the setting has 
changed.

Controlling Guest Access
The Guest Access feature lets the network administrator control 
who is allowed to view information about the server configuration. 
Guest Access is enabled or disabled for each individual server. The 
Guest Access setting affects all users who attempt to view server 
information from networked clients. Here is how Guest Access 
works:

■ When Guest Access is Enabled (the default), users who do not 
know the Adaptec CI/O Management Software password can 
view server information from a networked client connected to 
that server but cannot issue commands to change the server 
configuration.

■ When Guest Access is Disabled, users who do not know the 
Adaptec CI/O Management Software password cannot view 
server information from a networked client or issue commands 
to change the server configuration. However, users can still 
view event notifications generated by servers that are on that 
client’s server list. Users who know the password can view 

server information by double-clicking the icon and 
entering the password.
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Note: If you do know the server’s password you can 
perform array operations such as Creating and 
Deleting Arrays whether Guest Access is enabled or 
disabled.

Follow these steps to enable or disable Guest Access:

1 Open the Server View window by clicking the  button. 
Then select the icon of the server whose Guest Access setting 
you want to change.

2 Select Server Administration from the View menu. Then select 
Guest Access.

3 When the Enable/Disable Guest Access dialog box appears, 
select or deselect the Enable Guest Access check box.

4 Click OK to enter the change. Enter the Adaptec CI/O 
Management Software password when you are prompted to 
do so.

The Guest Access setting is changed on the server.

❒
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9▼  ▼  ▼  ▼
Managing Arrays and 
Spares
This chapter explains what to do when you need to replace a failed 
drive, physically reconfigure the disks in your server, and perform 
other tasks. 

Note: These steps apply to devices connected to array 
controllers only, and do not apply to SCSI adapters.

Responding to a Critical Array
A fault-tolerant (RAID 1, RAID 0/1 or RAID 5) array enters Critical 
status if one disk in the array fails. The array continues to operate 
normally, but you may lose data if a second disk in the array fails 
before the array is reconstructed. (RAID 0/1 arrays can continue 
operating in Critical status even if two or more disks fail, as long as 
at least one disk in each mirrored pair remains operational.)

If a spare disk is available, the array management software will 
reconstruct the Critical array automatically. When the reconstruct is 
complete, the array returns to Fault-tolerant status. If no spare disk 
is available, you should respond immediately to minimize the 
possibility of data loss. The most effective strategy is prevention: be 
sure that arrays are always protected by a spare pool or by dedicated 
spares!

In addition, you should monitor the status of arrays at all times with 
Adaptec CI/O Management Software to detect arrays whose status 
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is Critical. You can monitor arrays effectively by enabling the Popup 
Event Notification option so that a message appears on the screen 
whenever an array enters Critical status. You can also tell that an 
array is in Critical status if its icon in the Storage Configuration 

window looks like this .

Follow these steps to return a Critical array to Fault-tolerant status:

1 Click the Array icon  and observe the Disk icons of the 
array members on the left of the screen. One of the icons 

should look like this , indicating that the disk has failed.

2 Click the  icon and then click Operations.

3 When the Drive Operations window appears, click the

button to blink the drive light on the failed disk.

4 Observe which drive light is blinking. This is the disk that you 
need to replace. If no lights are blinking, this could mean one 
of the following:

a The disk is still connected but has failed so badly that it 
cannot respond to the Blink command. Try blinking the 
drive lights of the array disks that have not failed. You may 
be able to determine by a process of elimination which disk 
has failed.

b The disk has been removed or its power cord or SCSI cable 
has been disconnected.

If an array disk has been disconnected or removed but the 
server has not been rebooted, the icon for this disk will still 
appear in the Storage Configuration window. If you know 
that the disk was disconnected accidentally and has not 
actually failed, reconnect the drive and resume I/O to the 
array.
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If the server has been rebooted since the disk was 
disconnected, the disk will not appear. To determine if a 
disk is “missing” from an array, double-click the Array icon, 
and read the Status field at the top of the Array Information 
dialog box. If this field says Missing member, a disk is 
missing from the array.

c The disk does not have an LED that indicates I/O activity.

5 If the array enclosure does not support hot swapping1, pause 
I/O to the array before you continue. (Skip this step if the array 
enclosure supports hot swapping.) 

6 Replace the failed disk with a good disk, or replace the missing 
disk. Be sure to complete this step before the pause period 
expires.

7 After I/O resumes automatically, select the icon of the new 
disk, and issue a Create a Spare command.

8 When the spare has been created, select the Array icon and 
issue a Reconstruct command, if necessary (it is possible that 
the reconstruct will start automatically at this point).

When the reconstruct is completed the array is in Fault-tolerant 

status again, and the array icon will look like this 

Replacing a Spare
Follow these steps to replace a spare drive that is recognized as good 
by Adaptec CI/O Management Software:

1 Delete the spare (see Deleting a Spare on page 4-18).

2 If the spare is in an enclosure that supports hot swapping, 
remove the spare disk drive and replace it with another disk 
drive. Then skip to step 6.

3 If the spare is not in an enclosure that supports hot swapping, 
pause I/O (see Pausing I/O to an Array Disk Drive on page 6-17).

1 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad drive is replaced.
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4 Remove the spare and allow I/O to resume.

5 Pause I/O again, insert the replacement drive, and allow I/O 
to resume.

6 Use Adaptec CI/O Management Software to mark the new 
disk drive as a dedicated spare or a pool spare (see Creating 
Dedicated Spares or a Spare Pool on page 4-15).

Follow these steps to replace a spare drive that is recognized as 

down  by Adaptec CI/O Management Software. (This rarely 
occurs. Usually, if a spare disk fails a regular test of spares, CI/O 
automatically deletes the spare disk.)

1 If the down spare is in an enclosure that supports hot 
swapping, remove the spare disk drive and replace it with 
another disk drive. Then skip to step 5.

2 If the spare is not in an enclosure that supports hot swapping, 
pause I/O (see Pausing I/O to an Array Disk Drive on page 6-17).

3 Remove the spare and allow I/O to resume.

4 Pause I/O again, insert the replacement drive, and allow I/O 
to resume.

5 Use Adaptec CI/O Management Software to mark the new 
disk drive as a dedicated spare or a pool spare (see Creating 
Dedicated Spares or a Spare Pool on page 4-15).

You may need to low-level format the spare disk that you 
removed before you can re-use it.

Replacing an Active Array Member
Follow these instructions if you want to remove an array member of 
a RAID 1, RAID 0/1, or RAID 5 array that has not actually failed 
and replace it with another disk drive. You may want to do this if the 
drive has generated a S.M.A.R.T. predictive failure alert.

1 Perform a Down operation on the array member you want to 
replace (see Downing the Drive on page 6-16).

2 If the array member is in an enclosure that supports hot 
swapping, remove it and replace it with another disk drive. 
Then skip to step 6.
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3 If the array member is not in an enclosure that supports hot 
swapping, pause I/O (see Pausing I/O to an Array Disk Drive on 
page 6-17).

4 Remove the disk drive and allow I/O to resume.

5 Pause I/O again, insert the replacement drive, and allow I/O 
to resume.

The data from the array member will be reconstructed on the 
new disk drive. If a spare disk was already available, the 
reconstruct operation was begun automatically when you 
downed the array member.

Responding to an Off-Line Array
You can tell that an array is in off-line status if OFFLINE appears in 
the Array Status field in Adaptec CI/O Management Software for 
NetWare or if the Array icon in the Storage Configuration window 

looks like this: . There are several reasons for an array going 
off-line, as described below:

■ A second disk in a Critical RAID 5 array has failed, or both 
disks of a mirrored pair in a RAID 1 or RAID 0/1 array have 
failed.

If this happens, delete the off-line array, create a new array, and 
restore the data from your most recent backup. You cannot 
recover the array data if a second disk fails.

■ You were trying to replace a failed disk in a Critical RAID 1, 
RAID 0/1, or RAID 5 array, but you mistakenly pulled the 
wrong disk out of the array enclosure.

If this happens, reinsert the drive you mistakenly removed and 
issue the Reactivate Array command, which returns the array 
to Critical status. Then replace the correct disk, down the 
server, reboot, and reconstruct the array.

■ A cable to a good disk in a RAID 5 array accidentally became 
disconnected, and the array already had one failed drive; or a 
cable to a good drive in a RAID 1 or RAID 0/1 array 
accidentally became disconnected, and the other disk of the 
mirrored pair had already failed.
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If this happens, reconnect the cable, and use the Reactivate 
Array command to return the drive to Critical status. Then 
replace the failed disk and reconstruct the array.

Notes on Replacing Disk Drives
Some of these notes apply only to the ARO-1130SA and AAA-13xSA 
adapters, not to bridge controllers (see the list of devices on 
page 1-1.)

■ We recommend that if you use hot-swapping to replace a drive 
that supports tagged command queuing (TCQ), you replace it 
with a drive that also supports TCQ. Otherwise, a rescan 
operation may not detect that the drive has been swapped. 
Also, a system hang may occur if the replaced drive does not 
support TCQ and the system sends commands with tags to it. 
This problem will not occur if you swap drives while the 
server is down or while it is turned off.

■ To minimize the possibility of data corruption, we recommend 
that when you replace a disk drive you use a new drive of the 
same capacity or larger.

■ You must replace a device with the same kind of SCSI device 
when you are using Pause I/O. You should not, for example, 
replace a disk drive with a CD-ROM drive while I/O is 
paused.

■ When you replace a failed array member with a good disk 
drive with the same SCSI ID, information about the new array 
member is not written to the array members’ reserved sectors 
until a manual Reconstruct command is issued after the system 
is rescanned.

■ We recommend that you remove old or defective disk drives 
from the system as soon as possible. You must low-level format 
a removed drive before you can use it again.

■ A single disk cannot be replaced with a previously-used array 
member and be reported back to the operating system and the 
application layer properly. This means that if there is a channel 
failure, you cannot replace a single disk with an array member 
to make the array configuration complete and usable again 
while Adaptec CI/O Management Software is running.
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Optimizing Array Performance
If your Adaptec RAID product has multiple channels, you may be 
able to achieve better sequential data access when creating large 
arrays on powerful, high-end servers if some array members are 
connected to each channel.

The array management software and drivers allow you to use disks 
of various sizes and makes in the same array. To achieve the best 
performance, however, we recommend that you use disks of the 
same capacity and same model in an array. (If you use drives of 
different sizes, the amount of capacity actually used on each disk 
will be equivalent to that of the smallest disk in the array: For 
example, if you use five 1-GByte drives and one 500-MByte drive, 
only 500 MBytes on each disk will be used.)

You can also optimize array performance by selecting a RAID level 
for the array that best meets your needs for data reliability, 
read/write performance, and capacity use. See the following section 
for more information.

Selecting a RAID Level for an Array
The term RAID means Redundant Array of Independent Disks. An 
array is a grouping of disks that, by means of array management 
software, appears to the computer’s operating system as one large 
disk. Part of the storage capacity of most kinds of arrays contains 
redundant information about the user data on the array1. If an array 
disk fails, the contents of the disk can be regenerated on a new disk 
from the redundant information on the other array disks.

Compared with single disks, arrays can provide one or more of 
these desirable properties:

■ improved Read and Write performance by striping data across 
the disks in the array. This allows data to be read from or 
written to two or more disks simultaneously.

■ improved data reliability by storing redundant data to 
regenerate a failed array disk, as described above. This is 
especially important for servers, where arrays are most often 
used to store large amounts of mission-critical data.

1 RAID 0 arrays, which do not store redundant data, are an exception to this 
definition.
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■ improved capacity utilization by allowing you to manage a 
large number of disks as if they were one large disk. This 
makes it easier to back up data, create directories, etc.

All disks of an array (including spares) must be connected to the 
same Adaptec RAID product, though they can be connected to 
different channels. You can create dedicated spare disks for each 
RAID 1, RAID 0/1, and RAID 5 array. You can also create a pool of 
spares that can be used by any RAID 1, RAID 0/1, or RAID 5 array 
on the Adaptec RAID product.1

The array management software and firmware support RAID 0, 
RAID 1, RAID 0/1, and RAID 5 arrays. The advantages, 
disadvantages, and requirements of these RAID levels are as 
follows:

RAID 0 Arrays
Maximum Disks Allowed: 162

Minimum Disks Allowed: 13

In a RAID 0 array, data is distributed, or striped, across the disks in 
the array. The capacity of the array is approximately equal to the 
combined capacity of the physical disks. The I/O performance of a 
RAID 0 array is much better than that of a single physical disk 
because multiple reads and writes can be handled in parallel and 
because when large files are accessed the striped data is retrieved 
simultaneously from several disks.

RAID 0 arrays do not store redundant data and therefore are not 
true RAID applications. If one disk fails, the entire array fails and all 
data is lost. This means that the fault tolerance of a RAID 0 array is 
less than that of any single disk in the array. The term RAID 0 is 
widely used for these arrays, however, because they are 
conceptually similar to true RAID applications.

1 A disk in a spare pool can only be used to replace a failed disk in an array 
if it is at least as large as the smallest disk in the array.

2 The maximum would be 15 disks if the system has a single SCSI channel.
3 One-disk RAID 0 arrays are used only to control the virtual device order of 

single disks.
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RAID 1 Arrays
Maximum Disks Allowed: 2
Minimum Disks Allowed: 2

RAID 1 arrays use a single pair of disks. They are called mirrored 
arrays because both disks in the pair contain the same data. When 
data is written to a RAID 1 array it is written to each disk in the pair. 
The read performance of a RAID 1 array can be much better than 
that of a single disk, while the write performance is slightly worse. 
Mirrored arrays are highly reliable because the data is still safe if one 
disk in the pair fails. They are more costly, however, because you get 
only one disk of actual storage capacity from the pair of disks.

RAID 0/1 Arrays
Maximum Disks Allowed: 16 (must be an even number)1

Minimum Disks Allowed: 4

RAID 0/1 disks use from two to eight pairs of disks. They are called 
mirrored arrays because both disks in each pair contain the same 
data. The read and write performance of a RAID 0/1 array is much 
better than that of a single physical disk. RAID 0/1 arrays are highly 
reliable; the array data remains safe so long as at least one disk of 
each mirrored pair is good. Thus, in a 12-disk RAID 0/1 array, the 
array could continue working with up to six failed disks if one disk 
in each pair is still good. Because of the mirrored arrangement, 
RAID 0/1 arrays require twice as many disks as the actual amount 
of storage space.

1 The maximum would be 14 disks if the system has a single SCSI channel.
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RAID 5 Arrays
Maximum Disks Allowed: 161

Minimum Disks Allowed: 3

RAID 5 arrays contain redundant information in the form of parity 
data, which is calculated block-by-block for all user data. The parity 
data is distributed across all the disks in the array and occupies the 
equivalent capacity of about one disk. User data is interspersed with 
this parity data. If one disk in the array fails, its data can be 
reconstructed from the user data and parity data on the other disks. 
Two disks must fail before the entire array fails. The read 
performance of RAID 5 arrays is excellent and is comparable to that 
of a RAID 0 array. Write performance is slower than that of a RAID 0 
array, because new parity data must also be calculated and written 
when user data is written.

❒

1 The maximum would be 15 disks if the system has a single SCSI channel.
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Configuration Settings
This appendix describes the configuration variables that control the 
appearance of the Adaptec CI/O Management Software user 
interface and the way in which array and system operations are 
carried out. The variables controlling the user interface appearance 
are in the Windows NT registry. The other variables are defined in 
the iomgr.ini. and cioams.ini files

Many of the variables are configured for you once you install the 
software or start the program. If you are an advanced user and you 
want to customize your settings, you can edit the variables in the NT 
registry, or you can open iomgr.ini or cioams.ini in a text editor and 
manually make changes.
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iomgr.ini
The iomgr.ini file is located in the directory where the Adaptec CI/O 
Management Software is installed on your server. The section name, 
for example [ARRAYOPERATIONS], and the variables under each 
section are described below:

[ARRAYOPERATIONS]

Re-createPriority=
This variable specifies the priority of the automatic Re-create 
operation. Valid values are Low, Medium, or High. The default is 
Medium.

VerifyIfDirty=
This variable specifies whether you want to start the Verify 
operation if the array is dirty (meaning that the array was not shut 
down properly). Valid values are Yes or No. The default value is No.

DriverMonitoringFrequencyInSecs=
This variable specifies the maximum interval in seconds before 
Adaptec CI/O Management Software polls the driver. Any number 
of seconds can be specified; small values affect performance, large 
values (greater than 10 seconds) affect responsiveness to problems. 
The default value is 5.

[SYSTEM]

PauseEnabled=
This variable specifies whether the Pause I/O capability is enabled 
or disabled. Valid values are Yes and No.

ServerLogSizeInMegabytes=
This variable is used to limit the size of the Server Log database file. 
The Server Log database will be truncated if it grows beyond the 
size specified by the parameter. The size can be specified in 
increments of 1 MByte, up to a maximum of 10 MBytes.

StatisticsCollectionInterval=
This variable specifies the interval at which system statistics will be 
collected, assuming that the driver supports statistics collection. 
Values must be entered as whole numbers. The default value is 1.
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WarnAfterFirstPFAEvent=
If set to Yes, this variable specifies that if SMART events (PFA) are 
received from any drive the first event will be reported as a Critical 
event and all events after that will be reported as Warning events. If 
set to No, all SMART events will be reported as Critical. The default 
is Yes.

[TASKS]

TestAllSpares=
This variable schedules the Test All Spares operation. These jobs are 
not written to the Scheduler Database and are scheduled every time 
iomgr.nlm (NetWare) or iomgr.exe (Windows NT) is started. Valid 
values are 

■ Yes,H—Starts test every hour on the hour. For example, 
TestAllSpares=Yes,H

■ Yes,D,Time—Starts test daily at a specified time (military time 
format). For example, TestAllSpares=Yes,D,11:34. (The default 
value is to test all spares daily at 2:00 A.M.)

■ Yes,W,Day of the week,Time—Starts test weekly at a specified 
day and time (Day of the week: 0=Sun, 1=Mon, 2=Tues., etc.). 
For example, TestAllSpares=Yes,W,2,11:34 (starts every week 
on Tuesday at 11:34).

■ No—No tests are scheduled. For example, TestAllSpares=No.

[CAPABILITIES]

EnableRAID5=
This variable enables or disables the option of creating RAID 5 
arrays. If it is set to No users cannot create RAID 5 arrays. Valid 
values are Yes and No. The default is Yes.

EnableRAID10=
This variable enables or disables the option of creating RAID 0/1 
arrays. If it is set to No users cannot create RAID 0/1 arrays. Valid 
values are Yes and No. The default is Yes.
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[ENCLOSUREMANAGER]

EnabledEnclosureInterface=SAF-TE
This variable specifies the enclosure management interfaces that are 
supported by CI/O. Currently, only SAF-TE is supported.

SAF-TEPollingPeriodInSeconds=
This variable specifies the polling frequency, in seconds, for SAF-TE. 
This is the interval at which the SAF-TE enclosure is polled to check 
the status of all elements of the enclosure, such as power supplies 
and fans. The default is 5.

cioams.ini
The cioams.ini file is located in the \windows directory. The section 
name, for example [CORE], and the variables under each section are 
described below:

[CORE]

ConfigPath=
This variable specifies the default path name for the server 
configuration file. (The configuration file keeps a record of the 
server information.) For example, ConfigPath=configs.dat.

[VIEW]

ServerView=
This variable specifies whether the Server View window is 
displayed when the program starts. Valid values are 0 (is not 
displayed) and 1 (is displayed). If this variable is not specified, the 
default is 0.

[PROTOCOL]

IP=
If set to 1, Adaptec CI/O Management Software will attempt to load 
IP protocol when the program starts.

IPX=
If set to 1, Adaptec CI/O Management Software will attempt to load 
IPX protocol when the program starts. If you are only monitoring 
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Windows NT servers (and you are not monitoring any NetWare 
servers) we recommend that you set this variable to 0. This change 
will prevent a harmless, but annoying, error message from 
appearing.

[RPC ICONS]

Visibility=
Set this variable to Visibility=Hide to hide the RPC services icons 
when running Adaptec CI/O Management Software on a 
networked client.

[HEARTBEAT]

Interval=
This variable indicates the frequency, in minutes, at which the 
networked client attempts to connect to the server to get updated 
information. The default is 10.
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Windows NT User Interface Variables
The Adaptec CI/O Management Software user interface variables are 
located in the Windows NT registry under 
HKEY_LOCAL_MACHINE\SOFTWARE\Adaptec\Adaptec CI/O 
Array Management Software. These variables apply only to the server 
console version of Adaptec CI/O Management Software, not to the 
networked client installations:

■ Config Path: REG_SZ: configs.dat
This is the storage path for the configuration file.

■ Display Activity: REG_DWORD: 0
If the value is non-zero, the application will display the 
Activity Monitor window on startup.

■ Display Config: REG_DWORD: 0x2
If the value is non-zero, the application will display the Storage 
Configuration window on startup.

■ Display Server Log: REG_DWORD: 0
If the value is non-zero, the application will display the 
Historic Event Log window on startup.

■ Display Server View: REG_DWORD: 0
If the value is non-zero, the application will display the Server 
View window on startup. (This is not applicable to the desktop 
version of Adaptec CI/O Management Software.)

■ Notifications: REG_DWORD: 0
Popup Box is 0x1, Beep is 0x2, Flash Titlebar is 0x4, and None 
is 0x0. These values may be OR’ed together.

■ Server Name: REG_SZ: 

■ Severity: REG_DWORD: 0xd
Informational is 0x1, Warning is 0x4, and Critical is 0x8. These 
values may be OR’ed together.

■ Start Date: REG_SZ: 1/1/1990

■ Start Time: REG_SZ: 00:00:00
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I/O Manager Settings
The behavior of the I/O Manager may be changed by entries in the 
iomgr.ini file.

I/O Manager options (ASPI Manager Extensions) are configured by 
entries in the standard I/O Manager initialization file (iomgr.ini). A 
section headed [ASPIMODEL] can be added to this file. The 
available options are as follows:

DisableASPI = [Yes | No]

This option disables all ASPI Manager functions. This option may be 
used for problem isolation in I/O Manager systems that contain 
multiple managers.

DiscoveryInterval = n

This option configures the frequency (in seconds) that the Discovery 
phase is run. The default value is 1800 (30 minutes). System design 
precludes the possibility that a Poll phase or a Statistics phase will 
be active when a Discovery phase is activated.

PollInterval = n

This option configures the frequency (in seconds) that the Poll phase 
is run. The default value is 180 (3 minutes). If a Poll phase is 
activated when a Discovery phase is active, the Poll phase is delayed 
until the Discovery phase completes. System design precludes the 
possibility that a Statistics phase will be active when a Poll phase is 
activated.

StatisticsInterval = n

This option configures the frequency (in seconds) that the Statistics 
phase is run. The default value is 10 (10 seconds). If a Statistics phase 
is activated when a Discovery phase is active, the Statistics phase is 
delayed until the Discovery phase completes. System design 
precludes the possibility that a Poll phase will be active when a 
Statistics phase is activated.

Lun0Required = [Yes | No]

This option tells the ASPI Manager whether LUN 0 must be present 
before LUNs other than 0 will be checked. A setting of Yes requires 
that LUN 0 be present before non-zero LUNs will be checked. The 
default value is No.
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Lun0Only = [Yes | No]

This option tells the ASPI Manager whether or not to check LUNs 
other than 0. A setting of Yes disables non-zero LUNs. The default 
value is No, though this may vary by operating system type.

ErrorInstrumentation = [Yes | No]

This option, if Yes, enables the ASPI Manager to collect error related 
instrumentation from instrumentation capable drivers. The default 
value is No. If both this option and the IOInstrumentation option are 
set to No, then the ASPI Manager will not check for instrumentation 
capable drivers.

IOInstrumentation = [Yes | No]

This option, if Yes, enables the ASPI Manager to collect I/O related 
instrumentation from instrumentation capable drivers. The default 
value is No. If both this option and the ErrorInstrumentation option 
are set to No, then the ASPI Manager will not check for 
instrumentation capable drivers.

ResetInstrumentationOnPowerup = [Yes | No]

This option tells the ASPI Manager whether or not to issue an 
Instrumentation Reset to each instrumentation capable driver when 
the ASPI Manager initializes. The default value is Yes, which enables 
Instrumentation Resets. If both the ErrorInstrumentation and the 
IOInstrumentation options are set to No, this option has no effect.

ResetInstrumentationOnDiscovery = [Yes | No]

This option tells the ASPI Manager whether or not to issue an 
Instrumentation Reset to each instrumentation capable driver when 
that driver is newly discovered. The default value is Yes, which 
enables Instrumentation Resets. If both the ErrorInstrumentation 
and the IOInstrumentation options are set to No, this option has no 
effect.

SMARTPolling = [Yes | No]

This option tells the ASPI Manager whether or not to check whether 
SCSI devices support Predictive Failure Analysis, and if so to 
monitor them for SMART events. The default value is Yes, which 
enables SMART support. 
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SMARTTest = [Yes | No | testcount]

This option tells the ASPI Manager whether or not to enable 
Predictive Failure Analysis test mode. For debugging purposes, 
SMART capable devices internally have a test bit which allow them 
to generate SMART events even when the hardware is not having a 
problem. The default value is No, which does not enable any 
SMART debug events. Choosing option Yes turns the SMART debug 
bit on for all SMART capable devices and leaves it on. Providing a 
count instead of Yes turns the SMART debug bit on until at least 
count debug events are seen, then the SMART debug bit is turned 
back off. More than the requested count of debug events may be 
generated before the software can turn all debug events off. This 
option has no effect if SMARTPolling is set to No.

ForceHAWide16 = [Yes | No]

ForceHAWide32 = [Yes | No]

These two options are used to override the information obtained 
from the operating system driver about whether or not host 
adapters support Wide SCSI. These switches are especially useful 
with older drivers that do not report to ASPI whether or not a host 
adapter supports Wide SCSI. The default value for both switches is 
No, which forces ASPI to rely upon operating system driver 
information. If ForceHAWide16 is set to Yes, then all host adapters 
are assumed to support at least 16-bit Wide SCSI. If ForceHAWide32 
is set to Yes, then all host adapters are assumed to support at least 
32-bit Wide SCSI. 

If an operating system driver reports that a host adapter supports 
32-bit Wide SCSI when ForceHAWide16 is set to Yes, then that host 
adapter will still be treated as a 32 bit Wide SCSI device. In other 
words, these switches may “widen” a host adapter, but will never 
make it “narrower” than the operating system driver reports.

The switch values are only applied when a host adapter is 
discovered; if a host adapter already exists in the device database 
then these switches have no effect upon that host adapter or upon 
subsequently added devices. Therefore, the device database should 
usually be cleared after changing these switches.
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Note: Using these switches has the potential to cause ASPI 
to attempt I/O to a SCSI ID which cannot exist if a host 
adapter is forced wider than it is in reality. As the results of 
doing so are not predictable across all driver/operating 
system combinations, these switches should be used with 
care.

AccessibleDrivers = [* | comma delimited list of driver names]

This option controls which operating system drivers (and therefore 
which host adapters) will be managed by the ASPI Manager. The 
drivers are identified by the driver name returned when the ASPI 
Manager performs a host adapter inquiry. The names specified are 
inclusive – if a driver name does not appear in the list, then the ASPI 
Manager will ignore all host adapters which are accessed through 
that driver.

This option is especially useful when the I/O Manager includes 
multiple manager support, for example simultaneous SCSI and 
RAID host adapters. The ASPI Manager can be informed through 
this option to leave the management of the RAID host adapters to 
the RAID Manager. The option can also be used to inform the ASPI 
Manager to ignore any drivers that may cause problems, such as 
third-party device drivers.

The * syntax is used to specify that all host adapters are accessible. If 
the line:

AccessibleDrivers = *

appears in the .ini file, then the ASPI Manager will manage all host 
adapters it discovers.

The comma delimited list of driver names specifies, by name, which 
drivers will be managed by the ASPI Manager. The names are 
treated as prefixes. For example, specifying a name of AIC will allow 
the ASPI Manager to manage all host adapters whose driver names 
begin with the three character sequence AIC. The name may be 
specified in as many characters as the user wishes, so that the list 
might specify either a family of drivers or a specific driver. The 
names specified are not case sensitive.

The default is to manage all drivers beginning with AIC and AHA 
(although the driver names vary somewhat from system to system). 
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The default allows popular Adaptec host adapters, such as the 
AHA-1540 and AHA-2940, to be managed by the ASPI Manager. 
The default is equivalent to the .ini specification:

AccessibleDrivers = AIC, AHA, ADAPTEC AIC, ADAPTEC 
AHA, ADPT  AIC, ADPT  AHA

Note that putting an asterisk anywhere in the names makes all the 
other names meaningless. The specification:

AccessibleDrivers = AIC, *

would cause all drivers to be accessible, not just AIC drivers.

Up to 100 drivers may be specified, and the maximum length of the 
string of driver names is 255 characters. The names specified in the 
AccessibleDrivers statement may differ for different operating 
system platforms.

Drivers are only checked for accessibility when a host adapter is 
discovered; if a host adapter already exists in the device database 
then this option has no effect upon that host adapter or upon 
subsequently discovered devices on the host adapter. Therefore, the 
device database should usually be cleared after changing this 
option.

❒
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SAF-TE Enclosure 
Management
Adaptec CI/O Management Software provides easy management of 
SAF-TE enabled enclosures. Enclosures that support SAF-TE 
provide a standard, non-proprietary way for third-party disk and 
RAID controllers to be fully integrated with peripheral packaging 
that supports status signals (LED’s, audible alarm, LCD, etc.), hot 
swapping of hard drives, and monitoring of enclosure components.

Features of SAF-TE
The following features are supported by Adaptec CI/O 
Management Software:

■ Detecting Enclosures:

For all enclosures connected to SCSI, as well as RAID 
controllers, an event is generated identifying the address of the 
enclosure. Also, when you double-click on a channel icon, the 
device count that is displayed is incremented to include the 
enclosure.

■ Checking Enclosure Status:

CI/O Management Software periodically checks the status of 
all elements (disks, power supplies, temperature, fans, etc.) of 
all connected SAF-TE enclosures and generates associated 
events. These events can be viewed through the event log. 
CI/O Management Software also takes the following actions:
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– Reflecting the status on the enclosure: CI/O Management 
Software takes the appropriate action—changing the state of 
LEDs on the enclosure, setting alarms, etc.—when it detects 
statuses such as power supply failure or temperature out of 
range.

– Insertion/Removal of devices: CI/O Management Software 
detects insertion and removal of devices from the enclosure 
and generates appropriate events. The configuration is 
updated so that the inserted/removed device is reflected in 
the CI/O Configuration window.

If the removed drive is a SINGLE, CI/O Management 
Software automatically starts the Rescan operation. If the 
removed drive is an array member, CI/O automatically 
starts the array reconstruct operation, provided that at least 
one dedicated spare or pool spare is available.
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Description of Events
Adaptec CI/O Management Software identifies events related to 
each SAF-TE enclosure. Each enclosure is identified by a unique 
address (bus/host adapter, channel, SCSI ID, and LUN). This 
address is specified for all events logged for that particular 
enclosure, to allow easy identification of the enclosure. 

The following is a complete list of all events that may be generated 
for SAF-TE enclosures:

1 Enclosure found [SAF-TE: unique address]— For each found 
and successfully initialized SAF-TE enclosure, an event 
identifying the unique address is generated.

2 Enclosure not responding [SAF-TE: unique address]— For each 
unrecoverable error that occurred when communicating with a 
SAF-TE enclosure. CI/O Management Software stops polling 
this device until communication is recovered. On recovery, 
monitoring of this device starts automatically.

3 Enclosure removed from bus [SAF-TE: unique address]— 
Posted when an enclosure device is removed from the bus (for 
example, it was physically removed, power was switched off, 
etc.).

4 Device id=SCSI_ID slot#=slot_ number inserted [SAF-TE: 
unique address]— When a device is inserted into a SAF-TE 
enclosure slot, this event is posted. CI/O Management 
Software automatically performs a rescan on the controller to 
which the SAF-TE enclosure is attached.

5 Device id=SCSI_ID slot#=slot_number removed [SAF-TE: 
unique address]— Posted when a device is removed from a 
SAF-TE enclosure slot. If the removed drive is a SINGLE, CI/O 
Management Software automatically performs a rescan. If the 
removed drive is an array member, CI/O automatically starts a 
reconstruct, if there is at least one dedicated spare or pool 
spare.
B-3



Adaptec CI/O Management Software User’s Guide
6 For each change in the status of a cooling fan or temperature, a 
new status may be posted:

a Fan #fan_number is malfunctioning [SAF-TE: unique 
address]

b Fan #fan_number is removed [SAF-TE: unique address]

c Fan #fan_number is in an unknown state [SAF-TE: unique 
address]

d Temperature is out of normal range, sensor #sensor_number 
[SAF-TE: unique address]

e Overall temperature is out of normal range [SAF-TE: unique 
address]

CI/O Management Software attempts to spin up all other 
fans to maximum capacity to avoid possible overheating. As 
a result of this action, the following two events may be 
posted:

■ Fans are running at maximum capacity [SAF-TE: unique 
address]

■ Fan speed increase to maximum capacity has failed 
[SAF-TE: unique address]

f Fan #fan_number is operational [SAF-TE: unique address]

g Overall temperature is in normal range [SAF-TE: unique 
address]

CI/O Management Software attempts to slow down cooling 
fans. As a result of this action the following two events may 
be posted:

■ Fans are running at half capacity [SAF-TE: unique 
address]

■ Fan speed decrease to half capacity has failed [SAF-TE: 
unique address]
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7 For each change in the status of the power supplies connected 
to the enclosure, one of the following event notifications may 
be posted:

a PowerSupply #power_supply is operational and OFF
[SAF-TE unique address]

b PowerSupply #power_supply is operational and ON 
[SAF-TE unique address]

c PowerSupply #power_supply is malfunctioning and OFF 
[SAF-TE unique address]

d PowerSupply #power_supply is malfunctioning but ON 
[SAF-TE unique address]

e PowerSupply #power_supply is present [SAF-TE unique 
address]

f PowerSupply #power_supply is not present [SAF-TE unique 
address]

g PowerSupply #power_supply is in unknown state [SAF-TE 
unique address]

8 For each change in the status of the door lock of the enclosure, 
one of the following events notifications may be posted:

a Door is locked [SAF-TE unique address]

b Door is unlocked [SAF-TE unique address]

c Speaker is present [SAF-TE unique address]

d Speaker is not present [SAF-TE unique address]
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9 CI/O Management Software sets LED states of devices located 
inside enclosures in the following cases:

– Drive failed (failed drive is identified)

– Predicted fault (identifies the drive for which a S.M.A.R.T. 
event was received)

– Unconfigured drive (unconfigured drive is identified)

The following events are for devices connected to RAID boards 
only:

– Array rebuilding (all members of an array being rebuilt are 
identified)

– Array off-line (all members of an off-line array are 
identified)

– Critical array (all members of a critical array are identified)

– Array is being verified (all members of array being verified 
are identified)

– Hot spare (identifies a drive used as a hot spare)

– Rebuild failed (all members of array for which rebuild failed 
are identified)

❒

B-6



C▼  ▼  ▼  ▼
Using the ArrayConfigSA 
Initial Boot Array 
Installation Utility
This Appendix explains how to use the ArrayConfigSA Initial Boot 
Array Installation Utility to create and delete arrays and spare disks. 
You can use ArrayConfigSA to create a bootable array for the server. 
We recommend that you configure the server to boot from an array 
instead of from a single disk. This provides greater protection for 
network operating system files and data files stored on the array.

ArrayConfigSA runs from a diskette, so you can run it when the 
server is off-line and the operating system is not running. Nearly all 
ArrayConfigSA functions except creating a bootable array can also 
be performed with Adaptec CI/O Management Software, which 
runs under Windows.

The Installation and Hardware Guide for your Adaptec product has 
information on connecting SCSI devices, installing software, 
preparing to run ArrayConfigSA, and creating your first array with 
ArrayConfigSA. (The information on creating the first array is also 
included in this Appendix.)

Note: ArrayConfigSA is not supported for arrays on bridge 
adapters. See the bridge adapter Installation Guide for more 
information.
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Creating an Array with Array Config SA
You can create arrays with ArrayConfigSA or with Adaptec CI/O 
Management Software, which is described in chapters 2 through 9 of 
this document. However, if you want to install the operating system 
on the array, you must create the array with ArrayConfigSA. The 
following instructions can be used to create a bootable or a non-
bootable array.

Note: To select ArrayConfigSA menu options, type the hot 
key—the letter that appears in a different color. (The hot key 
letters are underlined in the following instructions). You can 
also press the ↑ and ↓ keys until the option is highlighted 
and then press Enter. If you have a monochrome monitor 
and the highlight bar is not visible, press Ctrl-B to change to 
monochrome mode.

1 Insert the copy of the ArrayConfigSA diskette in drive A of the 
server with the Array product and boot the server. The 
program will start automatically.

2 Select Disk Array Operations from the Main Menu.

3 Select Create New Array from the Disk Array Operations 
menu.

4 Type an array name and press Enter. The name can be up to 15 
characters long and can include spaces and any other printable 
characters.

5 Select an array type from the list. Your options are

– RAID 0: Data is striped across the disks in a RAID 0 array, 
allowing for faster I/O performance than a single disk. 
RAID 0 arrays do not store redundant data; if any disk in 
the array fails, all data is lost.

– RAID 1: Data is mirrored on one pair of disks. If one disk 
fails, data is still safe. The actual usable data capacity of the 
array equals half the available disk space.

– RAID 5: The array contains redundant (parity) data 
distributed across all disks in the array. If any one disk fails, 
data can be reconstructed from the parity information. If a 
second disk fails before the array has been reconstructed, all 
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data is lost. The actual usable data capacity of the array is 
equal to one less than the total number of disks. (One disk’s 
worth of capacity is needed to hold the parity information.)

– RAID 0/1: Data is striped and mirrored on two or more 
pairs of disks. If one disk in a pair fails, data is still safe. The 
actual usable data capacity of the array equals half the total 
available disk space.

See Selecting a RAID Level for an Array on page 9-7, for more 
information on RAID levels and RAID technology.

6 Type the number of drives you want in the array and press 
Enter. This number should not include spares (drives that will 
automatically replace failed array drives). The number of 
drives available for assignment is listed on the screen.

Note: This step does not apply to RAID 1 arrays, 
which have two drives by definition.

7 When the next screen appears, press Tab to highlight a channel 
(if your Adaptec product has more than one channel). When the 
drives on the highlighted channel appear in the SCSI IDs on 
Channel menu, select drives for the array. To do this, press the 
↑ and ↓ keys until the drive name is highlighted, and then 
press Ins or Enter. The names of selected drives appear to the 
right, in the Adaptec Array # box.

To select drives on a different channel (if necessary) press Tab 
to select another channel and then select the drives from the 
SCSI IDs on Channel menu. To deselect the drive you most 
recently added, press Del.

Caution: A warning appears if you select a disk that 
has partitions. Do not select disks with partitions if 
they contain data you want to keep, because any 
existing data will be erased when the disk becomes 
part of the array.

When you have selected the number of drives you specified in 
Step 6, the next screen appears automatically. If you are 
creating a RAID 1, RAID 0/1, or RAID 5 array, and if there are 

!

C-3



Adaptec CI/O Management Software User’s Guide
any unassigned drives, the screen prompts you to define 
dedicated spare drives for the array. (We recommend that you 
use a spare pool instead of dedicated spares. See Adding a Disk to 
a Spare Pool on page C-9 for more information.)

Note: A spare must have at least the capacity of the 
smallest drive in the array.

8 If you do not want a spare, type n and continue with Step 10. If 
you want to select dedicated spares, follow these steps:

a At the prompt, type y.

b At the next prompt, type 1 or 2.

c Select one or two spares, using the same method you used 
to select disks for the array.

9 When the Initialize Mode menu appears, select Initialize 
Array to Zero. Formatting begins immediately. A graph on the 
screen shows the progress of this operation.

Caution: If the drives contain data, all the data is lost 
when you initialize the array.

Select Low-Level Format only if the drives were previously 
formatted on another system or if you think they may have 
surface defects. Low-level formatting takes a long time for 
large disk drives. (See Initializing an Array on page C-7 for 
more information.)

Note: If your disk drives initialize very slowly when 
you create arrays, you may be able to speed them up 
by changing a setting in the arconfig.ini file (located on 
the ArrayConfigSA diskette). To do this, open 
arconfig.ini in a text editor and find this line: 

rem WriteSame=Yes
Delete the letters rem and save the file in text-only 
format. The next time you run ArrayConfigSA the 
disks should initialize faster.

!
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Another menu option, Skip Initialization, appears if you are 
creating a RAID 0 array. If you select this option, the RAID 0 
array will be created without being initialized. Unlike the other 
RAID levels, RAID 0 arrays are not required to be initialized 
before they are used. However, we recommend that you do 
initialize RAID 0 arrays.

10 When the menu of block sizes appears, select a block size. (This 
menu does not appear if the array is a mirrored array with only 
two drives.)

The allowable block sizes are 8, 16, 32, 64 (the default), and 
128 KBytes. The default block size gives the best overall 
performance in most network server environments.

11 When you see the message Initialization of [array name] is 
complete, press any key to return to the Disk Array Operations 
menu.

12 To create additional arrays (if disks are available), repeat Steps 
3-10. When all arrays are created, exit from ArrayConfigSA, 
remove the ArrayConfigSA diskette, and reboot the computer. 
After you reboot you can write data to the arrays.

Making the Array Bootable
Follow these steps to make the server boot from the newly created 
array or to change the boot order of existing arrays:

1 Select Display Boot Order from the Main Menu. The Boot 
Order for Singles and Arrays window appears.

2 If the newly created array is at the top of the list, preceded by 
the words Unit 0, no changes are necessary; if it has some other 
unit number, highlight the array name and press Enter to select 
it.

3 Use the arrow keys to move the selected array to the top of the 
list. Then press Enter to de-select it. If you want to change the 
boot order of another array, select it, move it with the arrow 
keys, and press Enter again.

4 When you are finished, press Esc to return to the Main Menu.
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Note: You cannot use this procedure to change the boot 
order of a SCSI disk drive that is not part of an array. If you 
want to do this, create a one-disk RAID 0 array from the 
disk. (Data is not actually striped on a one-disk array.)

For more important information on creating a bootable array, see the 
Installation and Hardware Guide for your Adaptec product.

Other Array Config SA Options
The remainder of this chapter explains how to use the other 
ArrayConfigSA options. You can also create and manage arrays with 
the Adaptec CI/O Management Software.

Displaying Array Information
Follow these steps to display information about existing arrays on 
the server or workstation:

1 Select Disk Array Operations from the Main Menu.

2 Select Display Arrays from the Disk Array Operations menu.

3 When the list of arrays appears, highlight the array for which 
you want information and press Enter.

4 View the information that appears on the screen. This includes 
array type and status, array size, and information about each 
disk in the array.

5 Press any key to return to the Disk Array Operations menu.

Deleting an Array

Caution: All data is lost when you delete an array! Before 
you delete an array, back up any data you want to keep.

Follow these steps to delete an array:

1 Select Disk Array Operations from the Main Menu.

2 Select Delete Array from the Disk Array Operations menu.

!
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3 When the list of arrays appears, select the array you want to 
delete.

Caution: A warning appears if you select an array that 
has partitions. Do not delete an array with partitions if 
it contains data you want to keep, because any 
existing data will be erased. Be especially careful not 
to select your boot array!

4 View information about the array and make sure you really 
want to delete it. Press any key to continue.

5 Type y to delete the array (or n to cancel the operation).

6 When the message [Array name] deleted appears, press any 
key to continue.

The drives that were formerly part of the array can now be used as 
stand-alone drives or as members of another array. Deleting an array 
may change the boot order and the drive assignment.

Initializing an Array
When you create a new array, you are automatically prompted to 
initialize (format) it. You can also select the Format/Initialize Array 
option as a separate command, perhaps to reinitialize an array that 
has become corrupted.

Here is more information on the two initialization methods:

■ Initialize Array to Zero: (Recommended method) Fills the 
array with zeroes. This option is faster than a low-level format, 
but it does not verify the integrity of the disks.

■ Low-level Format: Performs a low-level SCSI format. This 
writes a consistent pattern to the disks, checks the disks for 
defects, and fills the array with zeroes. Low-level formatting 
can take a long time if the disks are large.

Caution: Formatting or initializing an array erases all data 
on the array and cannot be aborted once it has started. If the 
array contains data you want to keep, be sure to back it up 
first!

!

!
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Follow these steps to initialize an array:

1 Select Disk Array Operations from the Main Menu.

2 Select Format/Initialize Array from the Disk Array Operations 
menu.

3 When the list of arrays appears, select the array you want to 
initialize.

4 Type y to confirm that you want to format the array.

Caution: A warning appears if you select an array that 
has partitions. Do not initialize an array with partitions 
if it contains data you want to keep, because any 
existing data will be erased. Be especially careful not 
to initialize your boot array!

5 When the Select Format Mode menu appears, select Initialize 
Array to Zero or Low-Level Format.

6 When the list of block sizes appears, select a block size. The 
allowable block sizes are 8, 16, 32, 64 (the default), or 
128 KBytes. (This menu does not appear if the array is a 
mirrored array with only two drives.) The default block size 
provides the best overall performance for most applications. 
Formatting begins immediately.

7 When you see the message Initialization of [array name] is 
complete, press any key to return to the Disk Array Operations 
menu.

!
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Creating and Deleting Spares
Spare disks (spares) are an important data protection and real-time 
recovery feature of RAID 1, RAID 0/1, and RAID 5 arrays. (RAID 0 
arrays do not support spares.) If a disk in an array fails while the 
server is running, a spare is activated immediately to take its place. 
The array software automatically reconstructs the necessary data on 
the new disk, and array operation continues uninterrupted.

You can create one or two dedicated spares, which can be used only by 
a single specified array. We recommend, however, that you create a 
spare pool instead. The spares in a spare pool can be used as needed 
by any array connected to the same controller, if the spare is at least 
as large as the smallest disk in the array. A spare pool can have up to 
eight disks.

Adding a Disk to a Spare Pool
Follow these steps to create a new spare pool or to add a disk to an 
existing spare pool. You should add a disk to the spare pool 
whenever one of these spares is automatically used to replace a 
failed array member.

1 Select Spare Pool Operations from the ArrayConfigSA Main 
Menu.

2 Select Add Device to Spare Pool from the Spare Pool menu.

3 Select a channel from the list, if necessary.

4 Highlight a disk to add to the spare pool and press Enter.

Caution: A warning appears if you select a disk that 
has partitions. Do not select disks with partitions if 
they contain data you want to keep, because any 
existing data will be erased when the disk is added to 
the spare pool. Be especially careful not to select your 
boot disk as a spare!

The spare is added immediately. Press any key to return to the 
Spare Pool Operations menu.

5 Repeat Steps 2-4 to add another disk to the spare pool. Spare 
pool disks can be connected to any channel on the adapter.

!
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Note: You can add a disk of any size to the spare pool, 
even if the disk is too small to protect the existing 
arrays. For example, if you have created two arrays 
with 1 GByte members, you can add a 500-MByte disk 
to the spare pool, even though this disk is too small to 
replace any failed array member. If you later create a 
third array with 500-MByte members, the smaller 
spare pool disk can automatically replace a failed 
member of that array.

6 When you have finished adding disks, press Esc to return to 
the ArrayConfigSA Main Menu.

Deleting a Disk from a Spare Pool
Follow these steps to delete a disk from a spare pool:

1 Select Spare Pool Operations from the ArrayConfigSA Main 
Menu.

2 Select Delete Device from Spare Pool from the Spare Pool 
menu. The disk most recently added to the spare pool is 
immediately deleted. Press any key to return to the Spare Pool 
menu.

3 Repeat Step 2 to delete another disk from the spare pool, if 
desired.

4 When you have finished deleting disks, press Esc to return to 
the ArrayConfigSA Main Menu.

Viewing Spare Pool Information
Follow these steps to view information about disks in a spare pool:

1 Select Spare Pool Operations from the ArrayConfigSA Main 
Menu.

2 Select Display Spare Pool Devices from the Spare Pool menu.

3 View the spare pool information that appears on the screen. 
When you are finished, press any key to return to the Spare 
Pool menu.
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Adding a Dedicated Spare
When you create an array you have the option of adding one or two 
dedicated spares to it. You can also add dedicated spares to an 
existing array at a later time.

Note: We recommend that you create a spare pool instead of 
using dedicated spares. See Creating and Deleting Spares on 
page C-9 for more information.

You cannot add dedicated spares to an array if

■ The array already has two dedicated spares

■ The remaining single disks are not at least as large as the 
smallest disk in the selected array

Follow these steps to add one or two dedicated spares to an array:

1 Select Disk Array Operations from the Main Menu.

2 Select Add/Delete Spare Drive from the Disk Array 
Operations menu.

3 Select the array to which you want to add the dedicated spare.

4 Select Add Spare Drive from the Add/Delete Spare menu.

5 Select a SCSI channel on the left, if necessary, and then press → 
to move to the list of disks on the right. Disks are grayed out if 
they are already used in an array or if they are smaller than the 
members of the array. Highlight an available disk and press 
Enter. Then select another disk for the second spare, if 
necessary. The new dedicated spare is added immediately.

Caution: A warning appears if you select a disk that 
has partitions. Do not select disks with partitions if 
they have data you want to keep; all data will be 
erased when the disk becomes a spare.

6 Press any key to continue.

!
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Deleting a Dedicated Spare
Follow these steps to delete a dedicated spare:

1 Select Disk Array Operations from the Main Menu.

2 Select Add/Delete Spare Drive from the Disk Array 
Operations menu.

3 When the list of spare drives appears, select the one you want 
to delete and press Enter.

4 Select Delete Spare Drive from the Add/Delete Spare Drive 
menu. The dedicated spare is deleted immediately.

5 Press any key to continue. The former dedicated spare can now 
be used as a spare in another array or as a member of another 
array.

❒
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SNMP/DMI Information
Adaptec CI/O Management Software fully supports SNMP and 
DMI v2.0.

■ SNMP (Simple Network Management Protocol) is used to 
allow a network management station to monitor workstations 
and devices on the network. The management station displays 
and updates information about the devices monitored by 
CI/O. System devices are managed with an SNMP agent. The 
sub-agent is the software program that implements the 
monitoring functionality.

■ DMI is a local interface, meaning that all elements are resident 
on a single workstation or server platform. DMI itself consists 
of the Service Layer, the Management and Component 
Interfaces, and the Management Information Formats (MIFs). 
DMI is intended to be a protocol-independent, multiplatform 
interface.

SNMP and DMI are provided for optional integration of CI/O 
within workgroup or enterprise management solutions. Examples 
include HP OpenView (SNMP) and Intel LANDesk (DMI). Contact 
your VAR or OEM for additional information on the use of these 
industry-standard management technologies.

For more information about how SNMP and DMI are supported 
under Adaptec CI/O Management Software, see the text documents 
cio20.mib and io.mif, respectively, on your installation media.

❒
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	4 Click OK when you are finished viewing the Log Detail dialog box. When you do this, you notify ...
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	6 Click Save As to save the event list to a file.
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	Figure 2�5. Default Event Viewing Filter
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	4 Click OK to record the Filter option changes.
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	Figure 2�6. Event Notification Options Dialog Box
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	4 Click OK to save these settings.
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	1 Click the button on the toolbar. The Historic Event Log window for the currently selected serve...
	Figure 2�7. Server Historic Event Log Window
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	3 Select Edit Permanent List. Enter the server’s password at the prompt. The Edit Permanent List ...
	Figure 2�9. Edit Permanent List Dialog Box

	4 To add a new networked client entry, type the IP or IPX address in the field at the top of the ...
	5 To delete a networked client entry, highlight the entry in the list box and click Delete.
	6 Click Close when you are finished. The changes are registered in the server’s permanent list file.
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	Figure 3�3. SCSI Information Dialog Box
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	Starting the Program
	1 Start Windows.
	2 Double-click the icon in the Adaptec CI/O Management Software group to start the program.
	3 Open the Server View window by clicking the button on the toolbar.
	4 Click the icon of the server whose arrays and spares you want to configure, as shown in Figure ...
	Figure 4�1. Server Icons

	5 Open the Storage Configuration window by clicking the icon on the toolbar. All array and spare ...

	Creating an Array
	1 Start Adaptec CI/O Management Software and open the Storage Configuration window, as described ...
	Figure 4�2. Storage Configuration Window

	2 Before you start defining the new array, decide what RAID level you want to use, how many disks...
	3 Select disks for the new array by clicking Disk icons that have the word Single beneath them, a...
	Figure 4�3. Selecting Array Members

	4 Click Create Array.... The Create Array dialog box appears, as shown in Figure 4�4.
	Figure 4�4. Create Array Dialog Box

	5 Type a name for the new array. The name can be up to 15 characters, including spaces and any ot...
	6 Select a RAID level for the array by clicking one of the buttons on the left. The bar graphs on...
	7 Select one or two disks from the list as dedicated spares. (Use Ctrl-Click to select multiple d...
	8 Click Advanced... to examine or change the Advanced Array options. The Advanced Array Options d...
	9 Click OK and then click Yes to confirm that you want to create the array. If error messages app...
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	11 Exit from Adaptec CI/O Management Software. Then reboot the server. (You cannot use the new ar...
	Setting Advanced Array Options
	Figure 4�5. Advanced Array Options Dialog Box
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	1 Start Adaptec CI/O Management Software and open the Storage Configuration window, as described ...
	2 Click the icon in the right part of the window for the array that you want to make bootable.
	3 Click Operations.
	4 Click .
	5 When the message appears, click OK to confirm that you want to make this array the boot device.
	6 Exit from the Adaptec CI/O Management Software. If the selected array does not already have a b...
	7 Install the operating system on the array. See your Adaptec RAID product’s Installation and Har...
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	2 Click the icon in the right area of the window for the array you want to delete.
	3 Click Operations.
	4 When the Array Operations dialog box appears, click to delete the array.
	5 When the confirmation message appears, click OK to confirm that you want to delete the array.

	Initializing an Array
	1 Start Adaptec CI/O Management Software and open the Storage Configuration window, as described ...
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	3 Click Operations.
	4 When the Array Operations window appears, click the button.
	5 When the confirmation message appears, click Initialize to confirm that you want to initialize ...

	Creating Dedicated Spares or a Spare Pool
	1 Start Adaptec CI/O Management Software and open the Storage Configuration window, as described ...
	2 Select the disk you want to configure as a spare by clicking on its icon in the left part of th...
	3 Click Create Spare... The Create Spare dialog box appears, as shown in Figure 4�6. A list of al...
	Figure 4�6. Create Spare Dialog Box

	4 If you want to dedicate the spare to a specific array, select Dedicated To and click the array ...
	5 Click OK to create the spare. A warning message appears if you select a disk that has a partiti...

	Deleting a Spare
	1 Start Adaptec CI/O Management Software and open the Storage Configuration window, as described ...
	2 Click the icon in the Array part of the window for the spare you want to delete. The icons for ...
	3 Click Operations
	4 When the Spare Operations dialog box appears, click the Delete button.
	5 When the confirmation message appears, click OK to confirm that you want to delete the spare.

	Managing Arrays on External RAID Controllers
	Figure 4�7. Arrays from External RAID Controller
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	Viewing Array and Device Information
	1 Select Configuration from the View menu, or click the icon on the toolbar.
	2 When the Storage Configuration window appears, double- click the icon that represents the devic...
	Figure 5�1. Storage Configuration Icons

	Viewing Array Information
	Figure 5�2. Array Information Dialog Box

	Viewing Spare Information
	Figure 5�3. Spare Information Dialog Box

	Viewing SCSI Device Information from an Array Controller
	Rescanning the Server
	1 Click the button on the toolbar. The Storage Configuration window appears.
	2 Click Rescan in the area between the Physical Resources and Array areas of the window.
	3 When the message appears, click Yes to confirm that you want to rescan the server. When the res...
	4 Click OK when the message appears indicating that the rescan was completed successfully.

	Viewing Array Controller Information
	Figure 5�4. Controller Information Dialog Box

	Viewing Channel Information
	Figure 5�5. Channel Information Dialog Box
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	Performing Array, Spare, and Disk Operations
	1 Select Configuration from the View menu, or click the icon on the toolbar.
	2 When the Storage Configuration window appears, single-click the icon that represents the array ...
	3 Click Operations. The Array Operations, Spare Operations, or Disk Operations dialog box appears.
	4 Click the button for the operation you want to perform. See the appropriate section of this cha...
	Performing Array Operations
	Reconstructing an Array
	1 Determine which array is in Critical status and which disk in the array has failed.
	2 If the array enclosure does not support hot swapping, pause I/O to the array. (See Pausing I/O ...
	3 Replace the failed disk (or disks) with a good disk of at least the same storage capacity. Be s...
	4 If you paused I/O in Step�2, wait until it automatically resumes after the pause period. If you...
	5 If you installed a new disk (or disks), make the disk into a spare by following the directions ...
	6 Select Configuration from the View menu. The Storage Configuration window appears.
	7 Click on the Array icon that looks like this . The Operations button becomes active.
	8 Click Operations. The Array Operations dialog box appears, as shown in Figure 6�1.
	Figure 6�1. Array Operations Dialog Box

	9 Click the button. If the array has one failed drive the Scheduler dialog box appears.
	10 Enter the required information for the Reconstruct operation in the Scheduler dialog box. You ...
	11 Select an Execution priority - high, medium, or low.
	12 Click OK.
	13 When the message appears, confirm that you want to reconstruct the array member.
	14 Read the event notifications that appear in the Server View window (they may also appear as po...

	Pausing I/O on an Array
	1 Open the Storage Configuration window and select the icon of the array you want to pause.
	2 When the Array Operations dialog box appears, click the button.
	3 When the Pause I/O dialog box appears, enter a pause interval that does not exceed the maximum ...
	4 Remove or replace the disk drive, as required. Data I/O resumes automatically at the end of the...

	Verifying Array Integrity
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on the Array icon . The Operations button becomes active.
	3 Click the Operations button.
	4 When the Array Operations dialog box appears, click the button to verify the data on the array....
	Figure 6�2. Scheduler Dialog Box

	5 Leave the autocorrect box checked so that any data parity or mirroring mismatches will be corre...
	6 Select Immediate if you want to verify parity immediately, or select Scheduled if you want to s...
	7 If you select Scheduled, enter a start time, start day of the week, and other information. (See...
	8 Select an Execution Priority - high, medium, or low. This sets the system resources devoted to ...
	9 Click OK to start the operation (if you selected Immediate) or to enter it on the list of sched...
	10 When the message appears, confirm that you want to verify parity information.

	Blinking Array Drive Lights
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on an Array icon in the right side of the dialog box. The Operations button becomes active.
	3 Click the Operations button.
	4 When the Array Operations dialog box appears, click the button.
	5 Look at the array enclosure to see which disks are members of the array.
	6 Click the Unblink all button in the Storage Configuration dialog box to stop the drive lights f...

	Reactivating an Off-line Array
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on the dimmed icon of the off-line array. The Operations button becomes active.
	3 Click Operations.
	4 When the Array Operations dialog box appears, click the button.
	5 When the message appears, confirm that you want to reactivate the array. Be sure that any hardw...

	Changing an Array Name
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click the icon of the array whose name you want to change. The Operations button becomes active.
	3 Click Operations.
	4 When the Array Operations dialog box appears, click the button. The Change Name dialog box appe...
	5 Type the new array name and click OK.
	6 When the confirmation message appears, confirm that you want to change the array name. This cha...

	Forcing a Spare
	1 Be sure that one or more spares are available for the array. These can either be dedicated spar...
	2 Select Configuration from the View menu. The Storage Configuration window appears.
	3 Click on the icon of the array with the suspect disk. The Operations button becomes active.
	4 Click Operations.
	5 When the Array Operations dialog box appears, click the button. This button appears dimmed if n...
	6 Select the disk that you want to replace.
	7 Click OK to replace this disk with a spare.
	8 When the confirmation message appears, confirm that you want to replace the disk with the spare.


	Performing Spare Operations
	Testing All Spares
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click the icon of any spare on the right side of the dialog box. The Operations button becomes ...
	3 Click Operations.
	4 When the Spare Operations dialog box appears, click the button. The Scheduler dialog box appear...
	5 Select Immediate if you want to test all spares immediately, or select Scheduled if you want to...
	6 If you select Scheduled, enter a starting time, starting day, and other information.
	7 Select an Execution Priority - high, medium, or low.
	8 Click OK to start the operation (if you selected Immediate) or to enter it on the list of sched...
	9 When the confirmation message appears, confirm that you want to test the spares.
	10 Read the pop-up message that appears when the test is completed. (The message is also recorded...
	11 Replace any failed disks immediately with good disks of at least the same capacity.

	Blinking the Spare Drive Light
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click a Spare icon in the right side of the dialog box. The Operations button becomes active.
	3 Click Operations.
	4 When the Spare Operations dialog box appears, click the button.
	5 Look at the array enclosure to see which disk light is blinking.
	6 Click Unblink all in the Storage Configuration window to stop the drive light from blinking.


	Performing Disk Operations
	Blinking the Drive Light
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click a Disk icon in the left side of the window. The Operations button becomes active.
	3 Click Operations.
	4 When the Drive Operations window appears, click the button.
	5 Look at the array enclosure to see which disk light is blinking.
	6 Click Unblink all in the Storage Configuration dialog box to stop the drive light from blinking.

	Downing the Drive
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Select the icon of the disk you want to pause.
	3 Click Operations.
	4 When the Drive Operations dialog box appears, click the button. If a spare is available, it rep...
	5 Wait until the Reconstruct operation is complete, then continue with your work in the program.

	Pausing I/O to an Array Disk Drive
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Select the icon of the disk you want to pause.
	3 Click Operations. When the Array Operations dialog box appears, click the button.
	4 When the Pause I/O dialog box appears, enter a pause interval that does not exceed the maximum ...
	5 Complete your work before the pause period expires. I/O resumes automatically at the end of thi...
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	Scheduling and Monitoring Array Operations
	Setting Scheduling Options
	1 Define a new scheduled operation: Reconstruct an Array, Verify Integrity of Array, or Test All ...
	Figure 7�1. Scheduler Dialog Box

	2 Select Immediate to perform the action immediately or Scheduled to schedule it for later.
	3 If you select Scheduled, select Once, Periodically, Daily, or Weekly. Enter other information s...
	4 Click OK to record the scheduling options. You may be prompted to confirm the activity.

	Viewing and Managing Scheduled Activities
	1 Select Activities from the View menu. The Array Activity Monitor window appears, as shown in Fi...
	Figure 7�2. Array Activity Monitor Window

	2 Select an Activity icon from the left part of the window. Information about the activity is sho...
	3 To change the priority of a Verify or Reconstruct operation that is currently running (as indic...
	4 To delete an activity that is not currently running, select its icon and click the Delete butto...
	5 To abort a currently-running activity, select its icon and click the Abort button. After you co...
	6 Click the Watch button to open a small window to monitor the selected, currently running activi...

	Monitoring Activities That Are Running
	1 Select Activities from the View menu. The Array Activity Monitor window appears.
	2 Select the icon of a currently-running activity from the scrollable list at the top of the window.
	3 Click Watch. A small Watch window for this activity appears, as shown in Figure 7�3. Each windo...
	Figure 7�3. Watch Window
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	Setting Security Options
	Changing the Password
	1 Open the Server View window by clicking the button. Then select the icon of the server whose pa...
	2 Select Server Administration from the View menu. Then select Change Password. The Change Passwo...
	Figure 8�1. Change Password Dialog Box

	3 Type the new password in the New Password field.
	4 Type the new password again in the Confirm Password field.
	5 Click OK to accept the new password.

	Setting Password Time-out Options
	1 Click the button on the toolbar. The Preferences dialog box appears.
	2 Select one of the three password time-out options listed on the right of the dialog box. Here i...
	3 Click OK to accept the password time-out change. You may be required to enter the password in o...

	Controlling Guest Access
	1 Open the Server View window by clicking the button. Then select the icon of the server whose Gu...
	2 Select Server Administration from the View menu. Then select Guest Access.
	3 When the Enable/Disable Guest Access dialog box appears, select or deselect the Enable Guest Ac...
	4 Click OK to enter the change. Enter the Adaptec CI/O Management Software password when you are ...
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	Managing Arrays and Spares
	Responding to a Critical Array
	1 Click the Array icon and observe the Disk icons of the array members on the left of the screen....
	2 Click the icon and then click Operations.
	3 When the Drive Operations window appears, click the button to blink the drive light on the fail...
	4 Observe which drive light is blinking. This is the disk that you need to replace. If no lights ...
	a The disk is still connected but has failed so badly that it cannot respond to the Blink command...
	b The disk has been removed or its power cord or SCSI cable has been disconnected.
	c The disk does not have an LED that indicates I/O activity.

	5 If the array enclosure does not support hot swapping, pause I/O to the array before you continu...
	6 Replace the failed disk with a good disk, or replace the missing disk. Be sure to complete this...
	7 After I/O resumes automatically, select the icon of the new disk, and issue a Create a Spare co...
	8 When the spare has been created, select the Array icon and issue a Reconstruct command, if nece...

	Replacing a Spare
	1 Delete the spare (see Deleting a Spare on page�4�18).
	2 If the spare is in an enclosure that supports hot swapping, remove the spare disk drive and rep...
	3 If the spare is not in an enclosure that supports hot swapping, pause I/O (see Pausing I/O to a...
	4 Remove the spare and allow I/O to resume.
	5 Pause I/O again, insert the replacement drive, and allow I/O to resume.
	6 Use Adaptec CI/O Management Software to mark the new disk drive as a dedicated spare or a pool ...
	1 If the down spare is in an enclosure that supports hot swapping, remove the spare disk drive an...
	2 If the spare is not in an enclosure that supports hot swapping, pause I/O (see Pausing I/O to a...
	3 Remove the spare and allow I/O to resume.
	4 Pause I/O again, insert the replacement drive, and allow I/O to resume.
	5 Use Adaptec CI/O Management Software to mark the new disk drive as a dedicated spare or a pool ...

	Replacing an Active Array Member
	1 Perform a Down operation on the array member you want to replace (see Downing the Drive on page...
	2 If the array member is in an enclosure that supports hot swapping, remove it and replace it wit...
	3 If the array member is not in an enclosure that supports hot swapping, pause I/O (see Pausing I...
	4 Remove the disk drive and allow I/O to resume.
	5 Pause I/O again, insert the replacement drive, and allow I/O to resume.

	Responding to an Off-Line Array
	Notes on Replacing Disk Drives

	Optimizing Array Performance
	Selecting a RAID Level for an Array
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	Configuration Settings
	iomgr.ini
	[ARRAYOPERATIONS]
	Re-createPriority=
	VerifyIfDirty=
	DriverMonitoringFrequencyInSecs=
	[SYSTEM]

	PauseEnabled=
	ServerLogSizeInMegabytes=
	StatisticsCollectionInterval=
	WarnAfterFirstPFAEvent=
	[TASKS]

	TestAllSpares=
	[CAPABILITIES]

	EnableRAID5=
	EnableRAID10=
	[ENCLOSUREMANAGER]

	EnabledEnclosureInterface=SAF-TE
	SAF-TEPollingPeriodInSeconds=

	cioams.ini
	[CORE]
	ConfigPath=
	[VIEW]

	ServerView=
	[PROTOCOL]

	IP=
	IPX=
	[RPC ICONS]

	Visibility=
	[HEARTBEAT]

	Interval=

	Windows�NT User Interface Variables
	I/O Manager Settings
	DisableASPI = [Yes | No]
	DiscoveryInterval = n
	PollInterval = n
	StatisticsInterval = n
	Lun0Required = [Yes | No]
	Lun0Only = [Yes | No]
	ErrorInstrumentation = [Yes | No]
	IOInstrumentation = [Yes | No]
	ResetInstrumentationOnPowerup = [Yes | No]
	ResetInstrumentationOnDiscovery = [Yes | No]
	SMARTPolling = [Yes | No]
	SMARTTest = [Yes | No | testcount]
	ForceHAWide16 = [Yes | No]
	ForceHAWide32 = [Yes | No]
	AccessibleDrivers = [* | comma delimited list of driver names]



	B
	SAF-TE Enclosure Management
	Features of SAF-TE
	Description of Events
	1 Enclosure found [SAF-TE: unique address]— For each found and successfully initialized SAF-TE en...
	2 Enclosure not responding [SAF-TE: unique address]— For each unrecoverable error that occurred w...
	3 Enclosure removed from bus [SAF-TE: unique address]— Posted when an enclosure device is removed...
	4 Device id=SCSI_ID slot#=slot_ number inserted [SAF-TE: unique address]— When a device is insert...
	5 Device id=SCSI_ID slot#=slot_number removed [SAF-TE: unique address]— Posted when a device is r...
	6 For each change in the status of a cooling fan or temperature, a new status may be posted:
	a Fan #fan_number is malfunctioning [SAF-TE: unique address]
	b Fan #fan_number is removed [SAF-TE: unique address]
	c Fan #fan_number is in an unknown state [SAF-TE: unique address]
	d Temperature is out of normal range, sensor #sensor_number [SAF-TE: unique address]
	e Overall temperature is out of normal range [SAF-TE: unique address]
	f Fan #fan_number is operational [SAF-TE: unique address]
	g Overall temperature is in normal range [SAF-TE: unique address]


	7 For each change in the status of the power supplies connected to the enclosure, one of the foll...
	a PowerSupply #power_supply is operational and OFF [SAF-TE unique address]
	b PowerSupply #power_supply is operational and ON [SAF-TE unique address]
	c PowerSupply #power_supply is malfunctioning and OFF [SAF-TE unique address]
	d PowerSupply #power_supply is malfunctioning but ON [SAF-TE unique address]
	e PowerSupply #power_supply is present [SAF-TE unique address]
	f PowerSupply #power_supply is not present [SAF-TE unique address]
	g PowerSupply #power_supply is in unknown state [SAF-TE unique address]


	8 For each change in the status of the door lock of the enclosure, one of the following events no...
	a Door is locked [SAF-TE unique address]
	b Door is unlocked [SAF-TE unique address]
	c Speaker is present [SAF-TE unique address]
	d Speaker is not present [SAF-TE unique address]


	9 CI/O Management Software sets LED states of devices located inside enclosures in the following ...



	C
	Using the �ArrayConfigSA Initial Boot Array Installation Utility
	Creating an Array with �ArrayConfigSA
	1 Insert the copy of the �ArrayConfigSA diskette in drive A of the server with the Array product ...
	2 Select Disk Array Operations from the Main Menu.
	3 Select Create New Array from the Disk Array Operations menu.
	4 Type an array name and press Enter. The name can be up to 15 characters long and can include sp...
	5 Select an array type from the list. Your options are
	6 Type the number of drives you want in the array and press Enter. This number should not include...
	7 When the next screen appears, press Tab to highlight a channel (if your Adaptec product has mor...
	8 If you do not want a spare, type n and continue with Step�10. If you want to select dedicated s...
	a At the prompt, type y.
	b At the next prompt, type 1 or 2.
	c Select one or two spares, using the same method you used to select disks for the array.


	9 When the Initialize Mode menu appears, select Initialize Array to Zero. Formatting begins immed...
	10 When the menu of block sizes appears, select a block size. (This menu does not appear if the a...
	11 When you see the message Initialization of [array name] is complete, press any key to return t...
	12 To create additional arrays (if disks are available), repeat Steps 3-10. When all arrays are c...

	Making the Array Bootable
	1 Select Display Boot Order from the Main Menu. The Boot Order for Singles and Arrays window appe...
	2 If the newly created array is at the top of the list, preceded by the words Unit 0, no changes ...
	3 Use the arrow keys to move the selected array to the top of the list. Then press Enter to de-se...
	4 When you are finished, press Esc to return to the Main Menu.

	Other �ArrayConfigSA Options
	Displaying Array Information
	1 Select Disk Array Operations from the Main Menu.
	2 Select Display Arrays from the Disk Array Operations menu.
	3 When the list of arrays appears, highlight the array for which you want information and press E...
	4 View the information that appears on the screen. This includes array type and status, array siz...
	5 Press any key to return to the Disk Array Operations menu.

	Deleting an Array
	1 Select Disk Array Operations from the Main Menu.
	2 Select Delete Array from the Disk Array Operations menu.
	3 When the list of arrays appears, select the array you want to delete.
	4 View information about the array and make sure you really want to delete it. Press any key to c...
	5 Type y to delete the array (or n to cancel the operation).
	6 When the message [Array name] deleted appears, press any key to continue.

	Initializing an Array
	1 Select Disk Array Operations from the Main Menu.
	2 Select Format/Initialize Array from the Disk Array Operations menu.
	3 When the list of arrays appears, select the array you want to initialize.
	4 Type y to confirm that you want to format the array.
	5 When the Select Format Mode menu appears, select Initialize Array to Zero or Low-Level Format.
	6 When the list of block sizes appears, select a block size. The allowable block sizes are 8, 16,...
	7 When you see the message Initialization of [array name] is complete, press any key to return to...

	Creating and Deleting Spares
	Adding a Disk to a Spare Pool
	1 Select Spare Pool Operations from the �ArrayConfigSA Main Menu.
	2 Select Add Device to Spare Pool from the Spare Pool menu.
	3 Select a channel from the list, if necessary.
	4 Highlight a disk to add to the spare pool and press Enter.
	5 Repeat Steps 2-4 to add another disk to the spare pool. Spare pool disks can be connected to an...
	6 When you have finished adding disks, press Esc to return to the �ArrayConfigSA Main Menu.

	Deleting a Disk from a Spare Pool
	1 Select Spare Pool Operations from the �ArrayConfigSA Main Menu.
	2 Select Delete Device from Spare Pool from the Spare Pool menu. The disk most recently added to ...
	3 Repeat Step 2 to delete another disk from the spare pool, if desired.
	4 When you have finished deleting disks, press Esc to return to the �ArrayConfigSA Main Menu.

	Viewing Spare Pool Information
	1 Select Spare Pool Operations from the �ArrayConfigSA Main Menu.
	2 Select Display Spare Pool Devices from the Spare Pool menu.
	3 View the spare pool information that appears on the screen. When you are finished, press any ke...

	Adding a Dedicated Spare
	1 Select Disk Array Operations from the Main Menu.
	2 Select Add/Delete Spare Drive from the Disk Array Operations menu.
	3 Select the array to which you want to add the dedicated spare.
	4 Select Add Spare Drive from the Add/Delete Spare menu.
	5 Select a SCSI channel on the left, if necessary, and then press Æ to move to the list of disks ...
	6 Press any key to continue.

	Deleting a Dedicated Spare
	1 Select Disk Array Operations from the Main Menu.
	2 Select Add/Delete Spare Drive from the Disk Array Operations menu.
	3 When the list of spare drives appears, select the one you want to delete and press Enter.
	4 Select Delete Spare Drive from the Add/Delete Spare Drive menu. The dedicated spare is deleted ...
	5 Press any key to continue. The former dedicated spare can now be used as a spare in another arr...
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